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Copyright

This manuali and the software described in it are copyrighted ©1987, 1988, 1989 by Digidesign
Inc. with all rights reserved. Under copyright laws, this manual and software may not be dupli-
cated in whole or in part without the written consent of Digidesign Inc., except in the normal use of
the software or to make a backup copy.

Limited Warranty

Except to the extent prohibited by applicable law, all implied warranties made by Digidesign inc. in
connection with this manual and software are limited in duration to ninety (90) days from the date
of the original purchase, and no warranties, whether express or implied, shall apply to this product
after said period. This warranty is not transferrable - it applies only to the original purchaser of the
software.

Digidesign Inc. makes no warranty, either express or implied, with respect to this software, its
quality, performance, merchantability, or fitness for a particular purpose. As a result, this software
is sold "as is", and you, the purchaser are assuming the entire risk as to quality

and performance.

in no event will Digidesign Inc. be liable for direct, indirect, special, incidental or consequential
damages resuiting from any defect in the software or documentation. Some states do not aillow
the exclusion or limitation of implied warranties or liability for incidental or consequential damages,
so the above limitation or exclusion may not apply to you.

License Agreement

Carefully read all the terms and conditions of this license agreement prior to using this
package. Use of all or any portion of this package indicates your agreement to the follow-
ing terms and conditions.

Digidesign Inc. grants to you, the purchaser, a non-exclusive license to use the software in this
package (the "Software"), under the terms and conditions stated in this agreement.

You may:
1) use the software on a single machine.
2) make one copy of the Software solely for backup purposes.

You may not:

1) make copies of the user manual or the Software in whole or in part except as expressly
provided for in this agreement.

2) make alterations or modifications to the Software or any copy or disassemble or decompile
the software or any copy, or otherwise attempt to discover the source code of the Software.

3) sublicense, lease, lend, rent or grant other rights in all or any portion of the Software or any
copy to others.

4) make verbal or media translations of the user manual.

5) make telecommunication data transmissions of the Software.

TERM: This agreement is effective until terminated. You may terminate it at any time by destroy-
ing the Software together with all copies in any form. It will also terminate if you fail to comply with
any term or condition in this agreement.
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This manual assumes that you have a basic
understanding of both the Macintosh and
your digital sampler. If you are not familiar
with the Macintosh, please take some time to
learn standard Macintosh terms and tech-
niques before using Turbosynth.

The Introduction describes Digidesign's update
and telephone support policies, and urges
you to send in your registration card.

Section 1 - Getting Started, covers basic hard-
ware requirements and proper system con-
figuration. Turbosynth file types and Sound
Designer file compatibility are also discussed.

Section 2 - About Turbosynth, is a basic tutorial
on the principles of sound and modular syn-
thesis. Read this section - it defines terms that
are used throughout this manual.

| Section 3 - Using Turbosynth (Part 1), describes

\bout This Manual

the basic tools and teaches you the overall
organization and operation of Turbosynth. It
also describes file and memory management,
and how to transfer sounds between the
Macintosh and sampler.

Section 4 - Using Turbosynth (Part 2), describes
the use of each Turbosynth module in detail.

Section 5 - Sampler Personalities, includes a
brief description of each Turbosynth compat-
ible sampler, and explains characteristics of
each sampler that affect it's use with Tur-
bosynth.

Section 6 - User Tips, contains many useful
sound design tips from an experienced Tur-
bosynth user.
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Hello!

Registration

Telephone Support

Introduction

Congratulations on your purchase of Tur-
bosynth software! Turbosynth is a new, unique
type of sound creating tool. It extends the
concept of software-based digital synthesis
and sound processing into new realms.

Our goal af Digidesign is to create interesting,
useful "toals” for musicians. You can help by
giving us feedback on our programs - do they
work for you? How can they be improved?
What features would you like to see? What
new types of programs would you like us to

| develop? We prefer written suggestions - it
helps to have something written when the
fime comes to add new features.

r It is very important that you let us know who
you are. Please send in your registration to-
day! if we don't receive your registration
card, we can't inform you of updates, send

‘ you our newsletter, or provide telephone sup-
port.

We have an excellent telephone support pol-
icy. Many soffware companies now charge
an additional fee for telephone support, or
limit the amount of free support. Our support
is free and unlimited. However, you must be @
registered owner to qualify for felephone sup-
port - send in that card foday!

If you need help, call (415) 327-8811 between
@.00 AM and 5:00 PM Pacific Standard Time.
Please read this manual carefully before call-
ing for help.

You will need your serial number when you
call for telephone support - it is written on the
back side of your master program disk.
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Future Turbosynth program updates will be
available 1o registered owners for a nominal
price. However, to receive information about
| program updates, you must be a registered
| owner. Have you sent that card in yet?

| If you plan to use Turbosynth with a hard disk,

read Appendix C, "Hard Disk Installation” care-
fully.
|
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What You'll Need...

Hard Disks

Using Turbosynth with
the Emulator Il and
Emax

Section 1 - Getting Started

| In addition to your Turbosynth software, you
will need a Macintosh with at least 1 Mega-
byte of RAM (Macintosh Plus, Macintosh SE or

| Macintosh 1), a double-sided (800K) disk drive
or hard disk and System/Finder configuration
4.2/6.0 (or higher). You'll also need a Macin-
tosh MIDI interface and a Turbosynth-compat-
ible digital sampling instrument to polyphoni-

| cally play back Turbosynth sounds. See the
back panel of the Turbosynth package for a
list of digital sampling instfruments that are
compatible with this version of Turbosynth.

In general, a hard disk has many advantages
for running Turbosynth. Digital sound files are
| very large, so they will quickly fill a floppy disk.
| Hard disks also run faster than floppy disks,
reducing the amount of time reqguired to gen-
erafe a set of new sounds,
| Emulator Il must have an RS-422 interface
cable to use Turbosynth, An RS-422 cable
may ailso be used with the Emax to provide
significantly faster transfer of sounds between
the Macintosh and Emax than MIDI. These
cables can be purchased directly from
Digidesign. An order form is included in the
Turbosynth package.

If you plan to use a sampler with a SCSI inter-
face (Emulator lll, Ensoniqg EPS, etc.) you will
need the appropriate SCSI cable. Depending
on your system configuration, you may aiso
need a SCSI terminator.

, Turbosynth is supplied with cne master pro-
gram disk and one sample files disk. Make a
I back-up copy of each disk.
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ection 1 - Getting Started

| The master program disk is copy protected

using "key disk" protection. Each time you
start up the Turbosynth program you must
insert the master disk. You will not be required
to insert the master disk again until you guit
and restart the program.

The Turbosynth program can be installed on a
single hard disk, bypassing the key disk copy
protection (the program can be run without
inserting the master program disk). See Ap-
pendix C, "Hard Disk Installation" for instruc-
tions.

| If you do not have a hard disk, you should run

Turbosynth from a copy of the master pro-
gram disk. Do noft run Turbosynth from the
master disk - keep it "locked” and use it only as
a "key" disk!

When you start Turbosynth from a copy of the
master disk, the program will ask you to insert
your master disk (the "key disk"). A few sec-
onds after you have inserted the key disk it will
be automatically ejected and the program
will start,

Plug the MIDI interface into either of the
Macintosh's serial ports (printer or modem).

- Use whichever port is convenient - Turbosynth

can use either port.

Connect the MIDI Out jack of the Macintosh
MIDI interfface to the sampler's MIDI In jack,
and the MIDI In jack of the Macintosh MIDI
inferface to the sampler's MIDI Out jack.

The hardware is now interfaced and ready to
go. Referto Section 5, "Sampler Personaiities’
to determine if your sampler requires any
additional set up.
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Setting the Serial Port,
Clock Rate, and MIDI
Channel/Device ID

Serlal Pork: Clock Rate: MIDI Channel/0evice 10:
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Section 1 - Getting Started

Turn on the Macintosh first, then the sampler.
Use your copy of the Turbosynth program disk
or your hard disk with Turbosynth installed as
your startup disk. Double click on the Tur-
bosynth program icon. After you have in-
serted your key disk and re-inserted your copy,
Turbosynth's main screen will appear.

Our first step is setting Turbosynth's MIDI para-
meters. Select MIDI Setup from the pull-down
MIDI menu. A dialog box will appear for se-
lecting the Serial Port, setfting the Clock Rate
of your MIDI interface and specifying a MIDI
Channel/Device ID for the sampler.

Click on the button next to the serial port your
MID! interface is connected to. Click on the
button next to the clock rate your MIDI inter-
face requires. Most Macintosh MIDI interfaces
use 1 mHz clock rates. Early Southworth inter-
faces and most Musicworks interfaces use 500
kHz clock speeds. Contact the manufacturer
if you are not sure of your interface's clock

| rate.

16 buttons are provided for setting the MIDI
Channel/Device ID. If you have more than
one of the same make/model sampler con-
nected to the Macintosh that supports MIDI
Device ID, assign each to a different device
ID number, then use this parameter to select
which one you want the Mac to communi-
cate with. This parameter also determines the
MIDI channel that Turbosynth's MIDI Keyboard
will use to transmit data.

After you set the Serial Port, Clock Rate and
MIDI Channel/Device ID, click on the OK but-
ton to return to the main screen.



slecting a Sampler

Irbosynth File Types

Docurnent

2ction 1 - Getting Started

o

Next, select the sampler you will use with Tur-
pbosynth from the list in the pull-down Sampler
menu. A checkmark will appear next to the
sampler's name when it is selected.

The MIDI Setup and Sampler setftings are
stored when you quit the Turbosynth program
you will not have to set them again unless you
use Turbosynth with a different sampler or MIDI
interface.

Before you use Turbosynth, it is important to
understand the three basic types of files that
Turbosynth creates: Document files, Sound
files, and Waveform files,

Document files store Turbosynth "patches.”
You create sounds with Turbosynth by con-
necting various sound generating and proc-
essing modules in the main window. A docu-
ment file includes all module parameters,
connections and sound data used in sample
rmodules (if "Save sound data with document”
is checked in the Sample module's info box -
see page 38). The sound represented by this
‘patch" can then be transferred to a sampler
for playback.

Turbosynth document files are created, stored
and refrieved from disk with the New, Save
and Open commands in the File menu. The
size of a document file depends on the com-
plexity of the patch and the amount of sound
data stored in the file,
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Section 1 - Gefting Started

Sound files consist of digital samples in the
Sound Designer format. These files can be
transferred to one of the samplers supported
by either Turbosynth or Sound Designer. They
can be "opened" intfo a sample module and
used as a sound source in a Turbosynth patch,

In addition, Turbosynth can save the sound
data representing the final result of the patch
as a sound file. This is done with the Save out-
put as sound file command in the File menu.

Any sound file created by Sound Designer
can be opened into a sample module in Tur-
bosynth. Conversely, you can directly open
any sound file created by Turbosynth if you
have a Sound Designer program.,

When a sound file is transferred to the sampler
by Turbosynth, it is automatically converted to
the format (i.e. 8 bit, 12 bit, etc.) required by
the selected sampler.

Waveform files contain the digital sound data
that represent regular waveforms in Tur-
bosynth. These files are used by the Tur-
bosynth oscillator module to generate sounds
with regular waveforms (such as friangle and
square waves) in a manner similar to hard-
ware oscillators,

Turbosynth allows you to modify preset wave-
forms and draw your own. You can even
isolate part of a sample in a sound file and
save it in a waveform file. These waveform
files are stored on disk with the Save loop as
waveform command in the File menu.
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Turbosynth supports the Digidesign Sound
Accelerator digital audio card, providing real
fime synthesis in most modules and acceler-
ated synthesis in all modules. If a Sound Ac-
celerator card is present, all acceleration will
occur automatically.

To hear 16-bit quality sound from your Macin-
tosh SE or I, launch Turbosynth and select
Sound Accelerator from the Options menu.

The following Options menu settings deter-
mine the way Turbosynth plays back sounds:

Sound Driver - When selected, sound play-
back will be heard out of the Mac's internal
specker. If a sound sampled at a very high or
very low sample rate sounds 'dirty’ out of the
Mac's speaker, fry selecting the Mac's play-
back rate in the Sample or Output module's
Info box.

Sound Manager - This setting also routes the
sound playback to the Mac's intemnal speaker.
Depending on which Macintosh model and
system software you are using, this option may
be disabled. Some experimentation should
be used between this setting and the Sound
Driver setting to achieve the best sound qual-
ity from your Mac and system software. Future
improvements to the Macintosh operating
system should allow better sound quality from
the internal speaker when the Sound Man-
ager is used.

Sound Accelerator - When the Sound Accel-
erator option is selected, sound playback will
be heard out of the Sound Accelerator card.
This option is disabled if no card is present or
no Sound Accelerator SE INIT file was present
in the Mac's System Folder during boot up of a

12
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Section 1 - Getting Started

Mac SE. If this option is disabled on your Mac
SE, verify that the Sound Accelerator SE INIT
file is present in your System Folder and restart
the Mac. The Sound Accelerator SE INIT file
can be found on the Softsynth master disk,
which is supplied with the Sound Accelerator,

Auto Preview - When this option is selected,
Turbosynth will automatically frigger playback
of the sound (upon release of the mouse but-
ton) affer any changes are made to module
faders, envelopes or oscillator waveforms,

Programmer General's Advice: Using Auto
Preview (from the Options menu) in conjuction
with the Sound Accelerator is highly recom-
mended while editing timbres in the oscillator.

When you change Mac models or system

| software, experiment with the Sound Manager
and Sound Driver settings to obtain the best
sound from the Mac's internal speaker.

13
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Section 2 - About Turbosynth

Turbosynth creates sounds using a modular
approach to synthesis. This tfechnique has
been used since the earliest days of elec-
fronic music, when analog synthesizers were
programmed using patch cords. On the posi-
tive side, modular synthesis provided com-
plete flexibility - modules could be patched in
any configuration, allowing the user to literally
"design” any imaginable synthesizer architec-
fure. On the negative side, however, patch
cords were clumsy to use and patches
couldn’'t be stored in computer memory.

Turbosynth combines the flexibility of modular
synthesis with the power and convenience of
moderm digital synthesis, sampling, sound
processing and storage technology. This com-
bination allows you to draw on the strengths
of each sound producing method to produce
the widest possible range of sounds. However,
to best understand how Turbosynth works, we
must first understand the basic principles of
sound and synthesis.

Sound consists of vibrations transmitted
through the air. These vibrations are created
by the movements of a sound source such as
a voice or a musical instrument. These move-
ments (i.e. the vibration of a vocal chord or a
guitar string) create finy pressure waves in the
air. When these waves reach our ears, our
eardrums vibrate and we perceive sound.,

If we convert these pressure waves to electri-
calimpulses using a microphone, the pressure
waves become an electrical voltage.
Changes in the intensity and direction of the
pressure waves become changes in the volt-
age level and polarity (positive or negative).
The result is an electronic waveform that rep-
resents the sound, and can be converted
back into air pressure waves using a speaker.
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ection 2- About Turbosynth

Sound waves that follow a repeating pattemn
have a characteristic known as pitch, and are
called periodic waveforms. The pitch of a
sound is determined by its fundamental fre-
quency - the number of repeated vibrations
per second. Frequency is expressed in Hertz
(Hz), or cycles persecond. For example,
middle C on a piano produces a sound wave
with a fundamental frequency of 264 Hz, The
healthy, young human ear can hear frequen-
cies that range from approximately 20 Hz to
20,000 Hz.

Pitched sound results from a periodic, repeat-
ing vibration. The specific pattem of this vibra-
tion is called the waveform of the sound. The
exact shape of these waveforms determines
the timbre, or tone quality, of the sound you
hear. Many synthesizers include oscillators
that produce some of the basic waveforms
such as square, friangle and sawtooth., How-
ever, most acoustic waveforms are more
complex than these.

The simplest type of waveform is called a sine
wave. The quality of the sound produced by
a sine wave is very pure and simple. A funda-
mental law of acoustics states that: Any com-
plex waveform can be broken down into a
series of sine waves at different frequencies
and amplitudes (loudness levels). These com-
ponent sine waves are called partials,

Sound is similar to light. If we pass sunlight
(complex light) through a prism, it is divided
into the colors of the spectrum. We cannot
see these individual colors when they are part
of the sunlight - they combine to create an
entirely different type of light. If we combine
all of the colors of the spectrum together, the
result is "complex” white light.
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Section 2 - About Turbosynth

Like light, complex sounds can be broken
down into their component sine waves, Sub-
tractive synthesis uses this principle by remov-
ing certain partials from a complex waveform
with a filter. Conversely, complex waveforms
can be "pbuilt" by combining sine waves of the
correct frequencies and amplitudes. This is
the basic principle behind additive synthesis,
Turbosynth is capable of performing both of
these types of synthesis.

In addition, Turbosynth is capable of perform-
ing amplitude modulation (AM) synthesis (in
which the amplitude of a wavefom is rapidly
modulated, or periodically varied) and fre-
quency modulation (FM) synthesis (in which
the fundamental frequency of a waveform is
rapidly modulated). Turbosynth can also
modify and play back sampled waveforms,
All of these methods of synthesis can be used
to produce a wide variety of interesting and
musical waveforms.

Changes in the amplitude of a sound as time
passes is called the envelope of the sound.
This is a characteristic of sound that plays an
important part in our ability to distinguish one
sound from another. It also results in a sound
that is much more interesting than one that
doesn't change over ifs duration.

Envelopes can also be simple or complex. A
typical analog synthesizer has a simple enve-
lope generator with four stages: attack, de-
cay, sustain and release. Turbosynth's ampli-
tude and filter envelope modules provide
complex envelopes with as many stages as
you wish. These complex envelopes allow you
to create very elaborate sounds that are not
possible with most analog or digital synthesiz-
ers.
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Modular synthesis combines various modules
that generate or modify a sound. These mod-
ules include oscillators 1o generate basic
waveforms, filters to modify the harmonic con-
tent of the signal from the oscillators and am-
plifiers to vary the volume of the sound. In
addition to these "traditional" modules, Tur-
bosynth includes a number of digifal sound
processing modules that did not exist in ana-
log modular synths.

Turbosynth combines the patching flexibility of
modular synths with a much wider range of
sound generating and processing functions. [t
also provides the advantages of patch stor-
age on disk and digital precision in the control
of a sound's parameters. By converting the
patches created in Turbosynth into sample
files for one of the currently available sam-
plers, they can dlso be enjoyed with excellent
fidelity in full polyphony.
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Now that we have reviewed the basic con-
cepfts of sound and modular synthesis, we're
ready to start creating sounds using Tur-
bosynth. If you have not already set up your
Turbosynth system, please do so now (see
Section 1, "Geftting Started").

Once your Turbosynth system is connected,
start the Turbosynth program by double click-
ing the mouse on the Turbosynth program
icon.

In a few seconds, the Turbosynth screen will
appear. This screen includes the Main Win-
dow in which sounds are created using the
icons in the palefte at the left of the window.
Each icon is selected by clicking on it once.
In most cases, the cursor becomes a small
version of the selected icon as you move it
info the work area of the main window.

There are six basic tools available in the main
document window of Turbosynth. They are
selected by pointing fo the desired tool with
the cursor and single clicking on it.

The Arrow is used to select icons, move mod-
ules around in the work area, and open mod-
ule windows. Also, if you hold down the Op-
tion key and click on a module, you can iso-
late the sound at that point in the patch. In
most cases, the cursor automatically reverts to
the arrow after any other activity.

The Eraser is used to erase modules and con-
nections in the work area. The cursor remains
an eraser until another icon is selected be-
cause you may wish to erase several items in
succession. To use the eraser, select it, move
the cursor into the work area, point to the item
you wish 1o erase and click on it.

Section 3 - Using Turbosynth (Part 1)



The Patch Cord is used to connect the mod-
ules you place in the work area. Like tradi-
tional modular synthesizers, Turbosynth's mod-
ules must be connected in order to hear a
sound. All modules have an output and most
have at least one input. In fact, the output of
each module can be split and routed to as
many different modules’ inputs as necessary.

In general, the signal from one module is
passed through another module in order to
modify the sound in some way. The output of
the first module is connected to the input of
the second module. The output of the sec-
ond module is then connected to the input of
the next module in the chain. This chain al-
ways ends at the output jack.

One module’s output is connected to another
module's input with a patch cord. Clicking on
the patch cord icon and moving the cursor
into the work area causes the cursor to take
the shape of a patch cord end. To connect
one module's output to another module's
input, click on the output module in the work
area, drag the cursor to the input module and
release the mouse button. The cursor retains
its shape as a patch plug after this operation
so that you can connect several modules in
succession without having to select the patch
cord icon for each connection.

By clicking anywhere on an existing patch
cord with the patch plug cursor and dragging
the mouse to another module, you can re-

| route the patch cord fo that module. The

20

eraser tool will also erase patch cords in the
work areaq.

Most modules allow a single input, although
some allow multiple inputs (e.g. mixers) and
others allow none at all (e.g. oscillators).

Section 3 - Using Turbosynth (Part 1)
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| The Speaker is used to hear the sound you
have created by connecting different mod-

} ules together, then connecting the last mod-
ule to the output jack. Clicking on it causes

| Turbosynth to play the sound present at the

| output jack.

| Note: If you have altered the patch in any
way since you last clicked on the speaker
icon, Turbosynth must take a few moments to
recalculate the numbers that represent the

| sound before it can be played. If you have
altered the patch and wish to hear the new

| sound immediately, you can hold the mouse

| pbutton until you hear the sound start,

The Info Box allows you to monitor and modify
the amount of memory available for use by
Turbosynth. Samples used indicates the fotal
amount of memory in samples (1 sample =2
bytes) used by modules in the current
document. Samples available indicates the
memory that is available to be used for new
modules. Normally, you will not be able allo-
cate the entire number of samples available
because additional memory is needed to
store module parameters,

If the system clipboard contains a Turbosynth
module that is no longer needed, you can
click on Release Clipboard to free up the
memory used to store the module data, If you
wish fo release any other data type from the
clipboard, simply create an empty sample
module and Cut it into the clipboard. This will
replace the previous clipboard contents. At
this point you can release the clipboard.

Compact Memory will de-fragment memory

so that free memory exists in one contiguous

block. Compact Memory also frees up mem-
I ory blocks that are no longer in use.

21
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dutput Jack

The Mac-to-Keyboard icon is used fo send a
sound file representing the patch in the main
window directly fo your sampler. Clicking on
the icon transfers the sound data present at
the output jack module to your sampler
through the MID! interface attached to the
Macintosh. A dialog box will appear allowing
you fo select a destination within your sam-
pler. This shortcut allows you to hear your
patches as they are played by your sampler
without first saving the sound data in the out-
put jack as a sound file and then transfering it
to your sampler via a File menu command.

Turbosynth includes 15 modules that generate
or modify sounds. These modules are placed
in the work area of the main window by click-
ing on them with the arrow and moving the
cursor into the work area. The cursor be-
comes a small version of the selected
module’s icon. Clicking in the work area
places the module at that location. The cur-
sor then reverts to the arrow shape, indicating
that it has returned to the selection mode.

Once in the work area, a module can be
repositioned by clicking on it with the arrow
and dragging it to the desired location in the
window. Asyou drag a module, you will no-
fice that its position changes in discrete
"'steps.” The work area includes an invisible
"grid" not unlike those found in most paint and

| graphic programs for the Macintosh. This grid

allows precise alignment of modules in the
window,

Whenever you open a new main window, you
will notice that there is one module already
present in the work area. This module is the
output jack. The modules in the work area
must be connected in some way to the out-
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Basic Parameters

Sample Rate

put jack in order for you o hear any sound
(the connections between modules are de-
scribed below with the patch cord tool). The
output jack is the only module that cannot be
erased or duplicated. There can be only one
output jack for each patch, This is fo insure
that every sound is unambiguously patched
to produce one output,

Note: A detailed description of all modules
appears in Section 4 of this manual, "Using Tur-
bosynth (Part 2)."

Like all digital audio systems, Turbosynth repre-
sents a sound as a series of numbers, These
numbers are stored in a section of the
computer's RAM called a "sound buffer." Typi-
caily, it takes tens of thousands of memory
bytes to store one second of sound.
Turbosynth creates a separate sound buffer
for each module in the work area. The exact
state of a module's sound buffer depends on
the seftings of the module itself and the input
it is receiving. This technique accounts for the
relatively high speed with which Turbosynth
can calculate and play a sound.

If you are using a Macintosh with 1 MB of RAM
and you intend to create complex patches,
you may wish to consider expanding your
memory to 2 MB or more. The additional
memory will benefit all uses of your computer,

All Turbosynth modules share two basic para-
meters: Sample Rate and Length. In addition,
Frequency is a parameter that is utilized by
many modules, They are defined as follows:

The Sample Rate parameter determines the
| number of sample points in each second of a
Turbosynth sound. Typically this number

23
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should maitch the sample rate commonly
used by your sampiler. See Section 5, "Sampler
Persondalifies” for a description of each
Sampler's playback sample rates.

The Length parameter determines the overall
length of the Turbosynth sound (in number of
samples). The actual length (in seconds) of
the Turbosynth sound is determined by both
the sound length and the sample rate. For
example, if the sample rate is 30,000 Hz
(samples per second), then a 30,000 sample
sound woulid be 1 second long, a 60,000
sample sound would be 2 seconds long, etc.
If we increase the sample rate and keep the
number of samples the same, the sound will
become shorter in duration.

The Frequency parameter is often the funda-
mental frequency of a sound. Enter a fre-
quency that corresponds to the musical note
you want to synthesize or process. "A"is a par-
ticularly easy note to synthesize because its
frequency is a multiple of 440 hertz (i.e. 220
Hz, 880 Hz, 110 Hz, efc.). 440 Hz is the default
setting for the frequency parameter.

Selecting Parameter Manager... from the Edit
menu displays a dialog box that allows you to
specify default setfings for the Sample Rate,
Length and Frequency of Turbosynth's moad-
ules. Any new modules created by the pro-
gram will automatically use these settings.

in adaition, the Parameter Manager dialog
box offers a number of options to further con-
trol the attfributes of Turbosynth's modules:

When the Inherit sample rate from input box is
checked, each module will use the same
sample rate as the module connected to ifs
input. Whenever a new connection is made

Section 3 - Using Turbosynth (Part 1)

ii_ﬂ
e N
|
= N
>
= 3
-:!_3
. 3
u
u 3
m 3
m
L
|
E 3
,IB
[
3
|
.
i
3
=
:
S|
e 3

|

Converting a Module
to a Sample Module

[ to the module's input, it will automatically

update to match the new input module.

When the Convert sample modules to default
optionis checked, any sound file that is

| opened into a Sample module will automati-

cally be sample rate converted to the default
sample rate.

When the Inherit length from input opftion is
checked, each module will each module will
use the same length as the module con-
nected to its input. If a new input connection
is made, the length parameter will update.,

When Dynamic length based on parameters is
checked, any modules which perform fime
alterations (specifically the Stretcher, Com-
pressor, Delay and Pitch Shifter) will derive their
length from their parameter settings. This fea-
ture is included to eliminate the need to con-
stantly readjust lengths of modules whenever
parameters are altered. For example, a short
percussive sound patched into a Delay mod-
ule will produce echos which increase the
overall length of the sound. In this instance,
turning on this option would automatically
calculate a length for the delay module
buffer based upon the length of the input, de-
lay time and amount of feedback.

If you create a complex patch with many
modules, your computer may eventually run
out of memory in which to create new sound
buffers. In this circumstance, you will see a
dialog box stating that there is insufficient
memory to add more modules if you try to do
so. Turbosynth provides a unique solution to
this problem. You can convert the module at
the end of the chain responsible for that
sound into a sample module and erase all of

the previous modules in the chain. The single
5
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Sample module will produce the same sound
as the entire chain of previous modules, al-
though the control offered by the intermedi-
ate modules will no longer be available.

m | You can save the sound data appearing at
! | the output jack as a sound file by selecting
Save output as sound file... from the File menu.

| i | This converts the sound as it is represented at

Select a module in the work area with the
{ arrow cursor and then select Convert to

File N .

the output jack to a Sound Designer format
sound file and saves it on disk. The use of
sample and waveform files within a Turbosynth
document is discussed in Section 4.

sample from the Edit menu to convert the

' selected module into a Sample module. The
sound buffer of the converted module is "fro-

releases the memory used for their sound buff-
ers and allows new modules to be added to
the patch.

m : Once you have created a sound file, you can
zen" and all erendence on ifs inputs is re- ! . | send it to your somp!e'r by selgcﬂng the Mac -
| moved. Erasing the now-extraneous modules > Sampler command in the File menu. Sound

Kk | files can also be opened into compatible
waveform editing software such as Sound
Designer.

Itis a good idea to save a separate version of
your patch in which the modules have not
been converted. This insures that you will be

| able to modify the sounds represented by
converted modules at a later time if neces-
sary.

m i | You can retrieve a sound file from your sam-

| pler and save it on disk using the Sampler ->

' 9 Mac command in the File menu. After retriev-
ing a sound file, you can include it in any Tur-
bosynth patch.

Note: The sampler you are using must be se-
lected from the Sampler menu. See Sections
1 and 5 for more information on sampler se-
lection.

11 One of Turbosynth's major advantages over

lle quogement | hardware-based modular synthesizers is the
ability to save patches on disk. These patches
can then be recalled and edited, played, or
sent to your sampler.

The Turbosynth Sample Files disk includes fold-
ers of example document, sample and wave-

File |} As you may recall from Section 1, Turbosynth form files. Use these files to become familiar
;| recognizes three types of files: ifs own Docu- with Turbosynth and as a starting point for
ment files, individual Waveform files and creating new sounds.
R ‘ Sound Designer format Sound files. Turbosynth

D e s ey o s e

document files are opened, saved, and
closed in the standard Macintosh manner
from the File menu. Turbosynth ailows you 1o
open as many document files as memory will
J permit. Of course, only one document file

can be active at atime. You cansave a

copy of the active document file under a

different name by selecting Save a copy in...
I from the File menu.

26 27

>ection 3 - Using Turbosynth (Part 1) Section 3 - Using Turbosynth (Part 1)

AR AR A RRM A AR EN RN E RN RN N



ansferring Sounds to | Turbosynth provides two methods of transfer-
ring sounds from the Macintosh to the sam-
e Sampler pler. The fastest method is to transfer the
| sound data present at the output jack. How-
ever, you can also fransfer any Sound De-
| signer format sound file o the sampler that is
stored on the Macintosh disk.

— | To transfer the sound data of a Turbosynth
% patch that is "open”, click on the Mac-to-Key-
| board icon in the palette. This will send the
sound data and loop points represented in
the Output Jack to the sampler directly from
| the Macintosh's memory. This transfer method
is the fastest because the Macintosh does not
need o read any data from its disk, and you
don't have to select afile to transfer.

Fite | To send a sound file from disk, select
| Mac->Sampler from the File menu. A dialog
box will appear with a list of sound files avail-

' | able on the current disk drive. Drive and Eject

| buttons are provided for selecting the current

drive or gjecting disks. Select the sound file
you want to send to the sampler, then click
once on the Open button.

After you click on the Mac-to-Keyboard icon

or select a sound file to transfer, the Macintosh

will atfempt to establish communication with

the sampler. If the Macintosh is not able to

communicate with the sampler for any reason

(e.g. the MIDl interface is not connected, the

wrong serial port is selected, etc.), a "Can't

Communicate" alert box will appear.  If this

happens. check the MIDI interface, RS-422

I cable or SCSI cable and communications set-
tings. If you still have trouble, see section &

| "Sampler Personailities' to determine if your

| sampler requires additional setup to fransfer
sounds.

28
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l Once communication has been established
between the Macintosh and sampler, a dialog

| box will appear for selecting a destination for
the Turbosynth sound file. Although the exact

‘ parameters displayed vary between samplers,
most allow you to either select an existing
sample you wish to replace with the tfrans-

| ferred sound, or to add the sound to the
samples already stored in the sampier's mem-

| ory. If you have difficulty setting the transfer
parameters, refer 1o section 5, "Sampler Per-

‘ sonalities".

If the sampler does not have enough free
sound memory to store the Turbosynth sound,
a dialog box will appear to warn you that the
tfransferred sound will be fruncated. In the
case of some samplers this may ailso result if
the transferred sound is longer than the sound
it is replacing.

Transferring Sounds Turbosynth can also transfer sound data from
the sampler to the Macintosh. After the sound

from ’rhe_SampIer fo data has been tfransferred, it is written to the

the Macintosh | Macintosh disk as a Sound Designer format
sound file, which you can later use in a Tur-
bosynth Sample module.

To tfransfer a sound from the sampler to the
Macintosh, select Sampler -> Mac from the
File menu. A dialog box similar to the Mac ->
Sampler dialog box described above will ap-
pear. Select the sound you wish to transfer to
the Macintosh, then click on the OK button, A
standard Macintosh file saving dialog box will
appear for naming the fransferred sound file.

Secfion 3 - Using Turbosynth (Part 1)
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The MIDI Preview feature (Sound Accelerator
card reguired) allows you to frigger poly-
phonic playback (two - eight voices) of the
current Turbosynth sound from any MIDI
device. While this feature is not intended to
replace a dedicated sampler, it allows poly-
phonic auditioning of sounds.

To use MIDI Preview, you must have a MIDI
keyboard or other MIDI device connected to
the Macintosh via the MIDI IN of a standard
Macintosh MID! interface. MIDI Preview re-
sponds to Note On/Off commands, with ve-
locity sensitivity and sustain looping (when
loop markers are placed). Audio playback
appears at the Sound Accelerator's audio
outputs.

When MIDI Preview is selected from the MIDI
menu, Turbosynth will display a dialog con-
taining a piano-style keyboard and buttons
for selecting the number of voices available
to play. By clicking on the keyboard, you can
designate which key the Turbosynth sound will
be played back without fransposition. This key
is referred to as the "root key" and will appear
with a gray box above it.

The range of notes Turbosynth is able to play is
designated by a black strip. You can change
the range of notes by either adjusting the root
key or the number of voices available. Also,
as the sample rate of sounds changes, so will
the transposition range. Due to these factors,
as well as overall system speed, the Macintosh
SE only provides the option of having two or
four voices. With a Macintosh Il you have the
option of using two, four, six, or eight voices.
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Module Windows

Module Info Box

20000 Samples
sample Rate: [31250 | Hertz

[J Normalize

Length:

@ Playback at Mac's sample rate
() Playback at module's sample rate
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Once you have selected several modules,
placed them in the work area of the main
window and connected them into a patch,
you must specify the parameters within each
module. Do this by double clicking on a mod-
ule in the work area. The module’s individual
window opens, allowing you to choose spe-
cific sound sources and set processing para-
mefters.

Most module windows have the same main
tools in the main window: the Arrow, Eraser,
Info Box, and Speaker. These tools apply to
each module window in the same manner as
their counterparts in the main window.

There are two types of Turbosynth modules.
Some include several special-purpose icons in
the palettes of their windows. These modules
are time oriented and have a scale marked
off in 50 millisecond (mMs) increments along the
bottom of the module window. Others pro-
vide "slider" controls to set parameter values
within the main portion of their windows. To
operate these controls, point o the slider, hold
the mouse button down, and drag the slider
to a new position.

Each module's info box is displayed by click-
ing on the Info icon in the module window. All
module info boxes include the Length and
Sample Rate parameters described in Section
3. All module info boxes also include a name
parameter that allows you to specify any
name for the module by typing it in the text
box provided.

In addition, all module info boxes include two
playback options: Playback at Mac's sample
rate and Playback at module's sample rate.
These options affect the way in which the

Section 4 - Using Turbosynth (Part 2)
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Macintosh plays the sound buffer of the mod-
ule. Selecting playback at the Mac's fixed
sample rate of 22 kHz resuits in a sound of
higher fidelity. However, if the module'’s
sample rate differs from 22 kHz, the sound will
not be played at the correct pitch.

The Normalize option appears in most module
info boxes. Checking the Nomalize box ad-
justs the sound buffer so that the highest peak
in the sound data is at 100% amplitude.

The Oscillator module accepts no inputs and
provides various waveforms as sound sources
in a Turbosynth pafch. The signal from an
Oscillator is usually routed to and processed
by other modules.

One of the unigue features of an Oscillator
module is its ability to crossfade from one
waveform into another. This provides much
more flexibility than any hardware oscillator
found in a synthesizer. Smooth crossfading
between waveform is accomplished simply by
placing several waveform icons in the main
portion of the moduie window at different lo-
cations along the time scale. The sound will
shiff smoothly from one waveform to the next
as the sound is played, To listen to a single
waveform without opening it, hold down the
Option key and click on the waveform's icon.

The Oscillator Info box is opened in the normal
way. It is the only module info box that in-
cludes the frequency parameter. The wave-
form files used by the Oscillator have no inher-
ent frequency of their own.,
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The oscillator has two modes: Waveform
Mode and Harmonic Mode. To switch be-
fween these modes click on the fwo upper
left icons in either an oscillator window or a
waveform window.

In Waveform Mode all presets and editing

| tools have a "waveform' orientation. In other

l

!

l
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words, the waveform is represented as ampli-
tude and phase. "Square wave”' and "triangle
wave" are common examples of waveform
types that have simple shapes.

In Harmonic Mode all presets and editing tools
have a "narmonic" orientation. The laws of
physics tell us that all sounds are composed of
different frequency sine waves. These sine
wave components are often referred to as
"‘oartials”. Partials that are multiples of the fun-
damental frequency of a sound are called
"harmonics”. For example, 880 Hz is the sec-
ond harmonic of a sound with a fundamental
frequency of 440 Hz. In Harmonic Mode, the
first 64 harmonics of a waveform are repre-
sented. In Harmonic Mode all presets and ed-
iting tools have a "harmonic series” orientation.
When switching frorn Waveform Mode to Har-
monic Mode, Turbosynth performs a Fourier
analysis on the waveform. The Fourier analysis
yields the relative amplitude of the first 64
harmonics of the waveform. When switching
from Harmonic Mode to Waveform Mode, Tur-
bosynth performs the inverse Fourier transform
to generate the waveform shape.

Turbosynth provides 11 preset waveform icons.
If the osciliator is in Waveform Mode the icons
will be miniature waveformes; if the oscillator is
in Harmonic mode the icons will be miniature
harmonic drawbars. To select one of the 11
preset waveforms in the palette, click on its
icon. Move the cursor into the window areaq

Section 4 - Using Turbosynth (Part 2)
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above the time scale and click again to
place the waveform at the desired location.
Use the arrow cursor to drag a waveform icon
already in the window to a new location. A
waveform's exact placement in time is deter-
mined by the position of the left edge of its
icon along the fime scale.

In addition to the 11 preset waveforms, you
can customize and create your own wave-
forms. This operation is performed in the
Waveform Window. To open this window,
double click on a preset waveform icon thaf
has been placed on the time scale. A large
representation of the preset waveform ap-
pears in this window. In the upper half of this
window's palette, you will see the same basic
tools (with the exception of the pencil, to be
described shortly) and preset waveform icons
as those found in the Oscillator window.

In the lower half of the paletfte are tools that
modify the displayed waveform. These tools
are used to increase and decrease the ampli-
tude of different parts of the waveform (and
induce clipping if desired), stretch and com-
press different parts of the waveform, and
add or remove noise from the waveform. The
best way fo become acquainted with these
fools is fo try them out.

The Pencil replaces the arrow in this window
and is used to freehand draw any waveform
shape. Select the pencil icon, move the cur-
sor into the main portion of the window, hold
the mouse button down and draw any shape
you wish. You can alter any part of the wave-
form or create an entirely new one.
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To edit the harmonic content of a waveform
in Harmonic Mode, double-click on the wave-
form’s icon in the oscillator time line. The Har-
monic Window will appear, displaying the
waveform's harmonic series. Harmonics 1 to
64 appear from left to right. The amplitude of
each harmonic is represented as a percent-
age. When the sum total of all harmonics is
greater than 100% ., the graph will represent
the relative mixture of all the harmonics. In
this case, the waveform that is generated by
the harmonics will be normalized. If, however,
the sum total of all harmonics is less than 100%
,then the graph represents absolute levels in
an un-normalized waveform (in a normalized
waveform, peak value = 100% amplitude.)

In the upper half of this window's palette, you
will see the basic tools used to edit the har-
monic series. The arrow is used to edit individ-
ual harmonics. Simply click on a harmonic
and drag up or down 1o raise or lower ifs level.

The rake is used to edit a group of harmonics.
By clicking and dragging you can create a
line segment. All harmonics with a level
greater than zero will move to this line. If you
hold down the option key while using the rake,
only harmonics above the line will be modi-
fied. If you hold down the option key and the
shift key, ali harmonics (including 0% harmon-
ics)-will move to the line.

In the lower half of the palette are tools that
modify the displayed harmonics. These tools
are used fo increase and decrease the ampli-
tfude of different parts of the harmonic series,
stretch and compress harmonic spacing, and
add or remove low level harmonics. The best
way to become acquainted with these tools is
to fry them out.

Section 4 - Using Turbosynth (Part 2)



Once you have created a waveform or har-
Mmonic series, you can save it on disk and use it
in any other oscillator. The Save waveform
command in the File menu is available when-
ever the Waveform window is active. Select-
ing this item from the File menu allows you to
name and save the waveform in the Wave-

| form window on disk.

jape guinut as saundiiie
jape laop as waueisnm
bave waveform

Custom waveforms can be loaded from disk

into the Oscillator or Waveform window. Cus-

tom waveforms can either be user created

waveforms, or waveforms extracted from

sampled sounds (for more details on sampled

| waveforms see the Sample Module section
that begins on the next page). If you are in
the module window, click on the small filing

| cabineticon in the palette. The cursor be-
comes a disk waveform icon that you can
place anywhere within the time scale. Once

| itis placed, the standard Macintosh disk file
selection dialog box appears. This allows you
1o select any waveform file on the specified

| disk. Clicking on the fiing cabinet iconin the
Waveform window opens the disk file selec-
tion dialog box immediately, allowing you fo
load a waveform from disk for further modifi-

| cation,

astom Waveforms

Clicking on the info icon in the Waveform

| window opens the Waveform Info box. This

| dialog box displays the name of the current
waveform window and the point in the Oscil-

| lator time scale at which it is located. It also
allows you to modify these two parameters.

Name: [Waveform

Time: Seconds

36
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Sample Module

Sample Info Box

Length:

45526 Samples
27777 Hertz

Loop Frequency: 1.840 Hertz

Semple RBate:

QO Playback at Mac's sample rate
@ Playback at module's sample rate

Xl Save sound data with document

| The Sample module allows you to include any

Sound Designer sound file as a sound source
in a Turbosynth patch. iIf you have the neces-

| sary hardware (Sound Accelerator and AD

IN)., you can also sample sounds directly into
Turbosynth. Samples can be directly manipu-
lated within the sample module or they can
be directed to and processed by other mod-
ules. Like Oscillators, Sample modules have
No inpufs.

Whenever a Sample module window is
opened for the first time after being placed
within the work area of the main window, the
standard Macintosh disk file selection dialog
box appears. This allows you to select a
sound file from disk to provide the data for the
module’s sound buffer (if you want to sample
directly into the sound buffer click on "Can-
cel). When you load and edit a sample you
will not affect the sound file on disk. You are
only editing a copy of the disk file.

The Sample module's info box displays and
allows you to edit the name, length, and
sample rate of a Sample module.

Note: Changing the sample rate in the info
box only changes the playback rate for the
sample (it does not perform sample rate con-
version), producing intferesting transposition ef-
fects. In this case, you will probably want the
other modules in your patch to have match-
ing sample rates. If so, use the Sample Rtae
Conversion function described on page 39 to
match the prevailing sample rate.

The Sample module info box also includes a
parameter called Loop Frequency. This pa-
rameter displays the length of the isclated
section between the loop markers. It is the

frequency with which the isolated section will
7
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yaving Sound Data
vith Documents

oading a Sample

irect Sampling

| repeat itself in aloop. If the data between
| the loop markers represents a single period of
a waveform, the loop frequency parameter

will equal the sound's fundamental frequency.

| For example, if the data between the loop
markers represents a single period of a sound
at 440 Hz, the loop frequency will be 440 Hz.

| However, if the data represents two periods of
a sound at 440 Hz, the loop frequency will be
220 Hz. The loop frequency is particularly
useful when sending a sampled sound to the
Stretcher and Resonator modules described
later in this section of the manual.

You can also save the sample sound data

| with the Turbosynth document file in which it

l appears by checking the Save sound data
with document box in the Sample module info
box. This precludes the need to load sound
files from disk every time you open a Tur-

f Posynth document that includes Sample
modules. However, this option contributes

significantly to the size of a document file

since sound files can be very large.

You can replace the sound in a Sample mod-
ule with new data by clicking on the filing
cabinet icon in the module window palette.
This opens a dialog box, allowing you to select
a new sound file to use,

With a Sound Accelerator™ and an Ad In™
you can sampie sounds directly into the
sample module. With this hardware Tur-
bosynth offers 44.1 kHz mono sampling. Affer
sampling you may wish to sample rate con-
vert the sampile to the rate used by your sam-
pler. The length of sampling is determined by
the size of the sound buffer. Open the
rmodule’s info box to set the length of sam-

} pling. Remember that the sample length
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should be set with respect to the 44.1 kHz
sample rate.

Once you have allocated memory and con-
nected an audio source to the AD IN, click on
the sampling icon. This will allow you to moni-
tor the input signal and adjust the sampling
trigger threshold. By clicking in the sample
time view (where the sample waveformis
normally displayed), the gray line representing
the threshold can be adjusted. To proceed
with sampling click on the sampling icon
again. Turbosynth will wait for the input signal
to exceed to sampling threshold and then
sample until the sound buffer is filled. If the
input signal does not exceed the threshold
level within approximately 10 seconds, Tur-
bosynth will guit sampling.

Sample rate conversion is often desirable
when a sampled sound has been imported
from one sampler (with one sample rate) and
is to be sent to another sampler (with a differ-
ent sample rate). Sample rate conversion is
also useful after direct 44.1 kHz sampiing.
Certain sounds, such as cymbals, can be dis-
torfed in the sample rate conversion process.
If this occurs send the non-converted sound to
your sampler and compensate for the differ-
ence in sample rate by adjusting the root key.

To convert the sample rate of the sample that
is currently displayed in the sample window,
click once on the sample rate conversion
icon. A didlog box will be appear displaying
the sample's current sample rate. To change
the sample rate, simply enter a new value in
the "Desired Rate" box,

Section 4 - Using Turbosynth (Part 2)
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i ‘g | fi 7 Envelope Removal The Envelope Removal function allows you to
tending the loop | The sample’s loop section can be extended F N P remove the inherent amplitude envelope of a
by clicking on the extension icon. This takes o
: the sound data located between the loop sampled sound. This will leave the sample at
markers, copies it and fills the sound buffer 2] 9 a clclan’rirnu;)us moxmrr;um le.ven" This effect is
with these copies until the sample reaches the . SIMIArio heavy compression.
length specified in its info box. This provides a = L | To process the sample currently displaved in
‘ time-limited loop of the selected section of - | 3 ’rhepsomeple e e ok oY S FT’heVEenve
the original sound, and can be used to ex- ' , P . -
‘ E lope Removal icon. A dialog box will appear
tend the sample to the desired length. l ‘ L )
: for specifying the Response time of the enve-
E 9 .
jin scaling The Gain Scaling function alters the ampli- | lope rermoval process.  The response fime
I E tude (gain) of a sample. This feature is useful &£ 9 pSOSrrOTe(;ird??(J;ecrlr:n]nﬁ’rsugoevéﬁglr’?kgsfi?\e‘rrsroc
|: for_ no.rm?Iizing a sample or for generating | seompe)lg Fast respoﬁse times mo%/ result ir?low
clioping .effec’rs. Ifa sompled soundhas @ ‘ | frequehcy distorfion or "pumping” because
low amplifude peak you will probably want fo | low frequencies are misinterpreted as ampli-
normalize it. This will increase the amplitude HE | ﬁ e P ; P!
of the sample so that its peak amplitude is at i Lucdceurcs %Tgoeg r‘r?we ?émglgzgéein%rggsg :E{'es
100%. Gain scaling that exceeds normaliza- 5 ) !
tion will ccuésle clipping. For cer’r%in sguncfdsd’rhis E i 9 ;’re;r?no]nsri;g%%oﬁ response times range
very desirable: snare drums can be "beefe ,_ :
| up" by clipping them. The gain scaling per- E 4 . o _
centage represents the nevlvfo(;npli‘;ude with . ! a Crossfade Looping vcvg’::'%dgo“s’ggg% 'Se glr ‘r?r?é?ﬁ)%;?rzg;hgrswfeirgc(i)n
respect to the original amplitude. For ex- 3 T ,
\ R \ . f |
om0 gainscalng of 0% wilproduco on - ] ] e T b e e
omph‘rudle ‘rhof‘résogl/e sq:lme C(Ijs fne ongmol.r A E i 9 crossfade looping functions available in the
gain scaling o b will produce an ampli- :
tude that is twice the original. A gain scaling E = Outpuf module. In general, vou will ;Nonf fo
of 50% will produce an amplitude that is half | ' S|eeﬁ%rmecrrﬁwsé?%eelggr?nlglgeIrrjnogulcéuspi)nlger?gg_
the original Ei 3 contents of the output module are Srronsferred
To cﬂhcmgeI ‘rhedgoi?hof the s?mpllec’lrho‘r is I‘Cir_ E: 3 1O fhe sampler for playback.
i i window, Clic :
genncg/ gﬁp?hc{;yga;g Scil?r?;r}gcjen. A dialog box | ] Once loop markers have been placed in the
will appear allowing you to normalize the E 4 currently displayed sample, click on the
sample's gain or enter a percentage amount l . crossfade looping icon fo display the
for changing the sample's gain. .:i - CLOSSfC'de Ic:opmg F?ﬁ'ﬁg:;ox- Tfh's dioflog box
allows you 1o speci e type of crossfade
t . (linear or equal power), and the length of the
| crossfade.
L& i L |
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I Linear crossfades tend to work best on sounds
with decaying envelopes (e.g. pianos, gui-
tars). Equal power crossfades tend to work
best on sounds with stable envelopes (e.g.
strings, borass).

Longer crossfade lengths fend to create bet-
ter sounding loops. The crossfade length is
limited by three ranges: 1) the distance be-
tween the start of the sound and the 1oop
start; 2) the distance between the loop start
and the loop end; 3) the distance between

|

v 4

L 4 L L

Playing the Loop

with the left-pointing marker to specify the
end of the selected section. Once placed,
the markers can be moved by dragging them
to the right or left with the arrow cursor. To
remove a loop marker, click once on it using
the eraser cursor.

To hear the loop. hold down the Command
key and click on the speakericon. The se-
lected section will loop until you release the
mouse button.

ad &

pEEEBRRRERRERRREN

| the loop end and the end of the sound. Keep The Loop Window To 99;0 'OOfP Thcf doesn't buzz, pop, OF,C'ACK
‘ this in mind when seﬁilng IooE| morke&s prior to C %gtj/es S%J:Erlgg\;ﬁgggdoigilgggs \?/hhécLoop
i oop. Also, make sure .
]| Window piaces s loop start ang end poin
dow 3 | side by side so that you can observe the tran-
' | sition. To open the Loop window, click on the
insfer Loop Points This function creates a selection withthe same q \mggmfymg glass icon in the Sample module
Selection start and end points as the loop start and loop mindow.
s | end. Thisis gsefu[ Ifyou wonf fo CUT (-:OPY or 4 SLiE=——= Lnp window =S| | Thie start and end points of the selected sec-
b W paste aregion without creating “ click ot : i [ ] l tion "wrap around" and meet in the center of
’rhe_edl’r transition. For exomple, if you cut a L} T the Loop window af fhe vertical dofted line
rng;rlon our;r o s%gfrf\d, ‘rh;e pom b(:?fqrrrwe;:?he | Mﬂ"« 5 The beginning of the selected section ap- '
cut may have a different amplifude - Mol | , , ,
point after the cut. This transition willgres;rﬁ a \M& J\j\ﬂ j gﬁgr(sjg\p’rggr:?nhlhheollégfggﬁ (\;??r?e()mr?gg\;heﬁ
click. By using the loop window fo adjust the - ] ‘ _ . ‘ oW
transition, you can select edit points that wil & 4 | g}gz,/ f;eveeTyigﬁj ?Q: Lrjrilg*%g:nﬂ;:ﬁg Ls,]jrrcmlso?wg
licks. -
not create clic E L] end points. The window does not necessarily
. display the entire section of sound defined by
op Markers Any portion of the sound can be selected = _ ,
4 1 | using the Loop Markers in fhe Sample module E 3 E | the loop markers. It only displays the first and
palette. The selected section can then be B 3 last parts of the selected section.
the loop or to extract new
\Lizsc?\(/jeff%newfﬁgﬁj use in e Oscilafor module. To achieve fhe smoothest possible loop, align
ln r| ’ the start and end points so that they meet at
To specify the beginning of the selected sec- ] or near the zero-crossing with a similar slope.
fon.cloc n thoghpoing oo morker 84 4 o be o coroIos e
icon, Move Thg rouse 1nf<') the main Po IT Hh l — follows the sound's natural waveform "pat-
the module window, position the culrsor C(lj © =] temn". You can hear the results of your adjust
desired location along the time scale an . an : .
click the mouse button. Repeat this process ‘! 4 i ments by clicking on the speaker icon. The
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selected section will loop for as long as you
hold the mouse button down. If you don't
hear the loop repeat, it is too short.

The scaling of the waveform in the Loop Win-
dow can be adjusted using the Zoom controls
in the Loop window paletfe. These controls
affect the display only, not the sound itself,
The vertical arrows adjust the amplitude of the
displayed sound wave. The horizontal arrows
adjust the amount of fime displayed in the
Loop window.

To adjust the location of the selection's start
and end points, simply position the arrow cur-
sor on the waveform at the desired location
and click. The waveform location you clicked
on will 'jJump" to the middle of the loop win-
dow, indicating that it is now the start (or end)
point of the selection.

The scroll bar arrows at the bottom of the
Loop window allow you 1o "fine-tune" the ex-
act position of the extension markers in single-
sample increments. These controls are used
to match the amplitude and slope of the start
and end points. Use the scroll bar arrows to
shift the start or end point to the right or left.

In addition to regular scroll arrows there are
Auto scroll arrows. These arrows allow you
move the loop points with automatic loop
point selection. This feature tries to find a
point that is similar to the loop point that is not
being moved. For example, if you auto-move
the loop start forward, it will advance the loop
start until it reaches a point that closely
matches the slope and amplitude of the loop
end point.
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Extracting Waveforms
from Samples

Sapa gutput as saundfiie
Save loop as waveform
Sgue wavefonn

Cut, Copy, Paste...
Editing

Turbosynth also offers the unique ability of
saving the sound data between the loop
markers as an oscillator waveform. This fea-
ture lets you extract a timbre from a sample
for use in an oscillator. Affer carefully match-
ing the start and end points of the isolated
section, select Save loop as waveform from
the File menu. A standard Macintosh save file
dialog box will appear, allowing you to name
the waveform file and save it on disk. The
waveform file can then be opened and used
by an Osciliator module.

Turbosynth's Sample module provides full cut,
copy and paste editing of samples. These
functions appear in Turbosynth's Edit menu.
To perform most edits, you will need to select
the section of the waveform you wish to edit.
Use the arrow cursor to select regions in @
sampled sound by positioning the cursor at
one end of the selection, clicking the mouse
button and dragging to the other end of the
selection. When a selection is made, clicking
on the speaker icon will only play the selected
region.

The Cut command removes the selected sec-
tion of the waveform and stores it in the clip-
board (a temporary storage buffer for data).

The Copy command makes a copy of the
selected waveform section and stores it in the
Clipboard.

The Paste command inserts the contents of
the clipboard (the last waveform section you
copied or cut) info the sample at the current
insertion point. If a section of the sample is
selected, it will be deleted and the contents

of the clipboard will be inserted in its place.

45
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ies e | The Amplifier Envelope module accepts one g [ | The Filter Envelope accepts one input and
nplifier Envelop input and varies the amplitude of the input | Filter Envelope P, provides a variable low-pass filter. The Fiiter's
/=] | signal from 0% to 100% over time according to | : ‘ cut-off slope is 6 db/octave. Ifs function is
the envelope within the module window. Its i ~ similar o that of the voltage-controlled filters
T function is similar to that of the voltage-con- (VCF) found on analog synthesizers.
7"-—-—"”&—% ‘ trolled amplifiers (VCA) found on analog syn- - |
O thesizers. | The Filter Envelope window looks and behaves
H o ‘ in exactly the same manner as the Amplifier
Tpooose a100ume 20010 320 The envelope that determines how the ampli- i Envelope module (see the previous page for
™ | tude will vary is selected from the palette of 4 more information). The only difference is that
Norrrrrmm rE | eight small preset envelope icons. Click on a ' the envelope in this window conftrols the cut-
preset envelope icon in the palette to select e | off frequency of the filter instead of the level
it. The selected envelope appears in the i~ of amplification.
module window.
‘ When the envelope reaches the top of the
Once selected, a preset envelope can be window, the filter is entirely open. At the bot-

modified in several ways. The four modifier
icons at the bottom of the palette alter the
envelope in a regular, global fashion. Clicking
on one of these icons shifts the entire enve-
lope in the direction indicated by each icon.
The amplitude (vertical) modifiers move all
points up or down equally. The fime (horizon-

| fom of the window, the cut-off frequency is

approximately 500 Hz.

If you wish to increase the slope of the Filter
after the cut-off frequency, you can cascade
Filter modules. Passing a signal through two
identical Filter modules in series increases the

W W W a W W

tal) modifiers move all points to the right or left slope to 12 db/octave.
prlop:or‘riTonoHy ﬁeaﬁnding on their position s | ;
relative to each other. pectral Inverter The Spectral Inverter module accepts one
input and inverts the harmonic spectrum of

The arrow cursor can be used fo alter the en- “=>"' the input signal. Like the Filter Envelope mod-
velope in any way you choose. Think of the | I s ule, it alters the timbre of the input sound over
envelope as a rubber band. Click the arrow ~ fime.
cursor on any point in the envelope and drag ’
the point to a new location. The selected e i <>J:if/\ The Spectral Inverter module window looks
point doesn't need to be one of the break- a Soaa [ identical to those of the Ampilifier and Filter
points in the preset envelope. Any point C | ’_"Ff\'“j_: oo e’ by | Eyelope modules. In this case, however, the
along the entire envelope can be selected : N envelope determines the mix between the
with the arrow cursor and moved to a new ' E | T T T T inverted and non-inverted signals. When the
location. This provides exceptional flexibility in ) envelope reaches the top of the window, the
creating custom envelopes. L harmonic spectrum of the output signal is

| completely inverted with respect to the input

E | signal. When the envelope reaches the bot-
tom, the input signal is unaffected.
46 A4 47
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As you may recall from Section 2, any com-
plex sound wave is made up of component
sine waves. These sine waves, known as par-
tials, collectively form the harmonic spectrum
of the complex waveform. It is this harmonic
spectrum that is affected by the Spectral In-
verter module. In order fo understand the
function of this module, a bit of digital audio
theory is required.

Analog sound waves are represented in digi-
tal audio systems (such as samplers) by taking
many instantaneous readings of the sound
wave's level, then storing this stream of num-
pers in RAM. These numbers can then be
manipulated and played back. The rate at
which these readings are taken or played
back is known as the sample rate.

Frequencies higher than half the sample rate
cannot be accurately represented in digital
form. The frequency equal to one-half of the
sample rate is known as the Nyquist fre-
quency. It is the highest frequency that can
be accurately represented in a digital audio
system.

The Spectral Inverter uses two different meth-
ods to shift frequencies:

Type A takes the input signal's harmonic spec-
frum and inverts it around the halfway point
between 0 Hz and the Nyquist frequency. For
example, suppose that the sample rate is 30
kHz. The Nyquist frequency is therefore 15 kHz.
If a sound has a partial at 0 Hz, it would be in-
verted to 15 kHz . Likewise, a partial at 100 Hz
would be inverted to 14.9 kHz, and a partial at
7.4 kHz would be inverted to 7.6 kHz. A partial
at half the Nyquist frequency (7.5 kHz in this
example) would remain unchanged.
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"Type B" Spectral
Inversion

Type B takes the input signal's harmonic spec-

‘ trum and creates fwo spectral "images" of it.

One image is the original frequency shifted by
one fourth of the sample rate. For example, if
our sample rate is 30 kHz and a sound has a
partial at 0 Hz, it would be shifted to 7.5 kHz.
Likewise, a partial at 100 Hz would be shifted
to 7.6 kHz, and a partial at 7.4 kHz would be
inverted to 14.9 kHz.

The second image inverts the harmonic spec-
tfrum around the point that is one-quarter of
the distance between 0 Hz and the Nyquist
frequency. In our example, a sound which
has a partial at 0 Hz would be inverted 10 7.5
kHz: a partial at 100 Hz would be inverted to
7.4 kHz; and a partial at 7.4 kHz would be in-
verted to 100 Hz.

These two images are then combined to pro-
duce the outfput sound.

Sounds confusing? That's because itis. Don't
panic. All you really care about is how it
sounds. Type A tends to produce very high
frequencies. Type B tends to produce more
upper midrange frequencies, as well as high
frequencies, The actual results depend en-
tirely on the input to the spectral inverter. This
moduie is most effective when the input signal
is rich in partials, particularly those of high fre-
guency. Experiment with Type A and Type B
on various broadband samples (e.g. percus-
sion, pianos, etc.).
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slay Module

The Delay module accepts one input and
performs much the same function as a stan-
dard outboard digital delay unit. This
module’s parameters are specified with the
slider controls located in the main portion of
the module window. The eraser resetfs any
control to which it is applied to zero.

The delay time is set with the Coarse and Fine
sliders. To change the delay time, simply point
1o one of these sliders with the arrow cursor,
hold the mouse button and drag the slider up
or down to a new setfing. The delay time is
displayed under the coarse slider.

The Feedback control adjusts the percentage
of the wet (delayed) signal that is directed
back to the input of the module. A setting of
less than 100% results in less and less feedback
signal with each passing delay cycle. The mix
control determines the relative levels of the
wet and dry (unaffected) signals in the final
output. A mix value of 100% indicates a com-
pletely wet output signal,

The Polarity control performs a phase inversion
on the processed signal. Select Positive or
Negative polarity by clicking the arrow cursor
on the desired setting. The aural effect of this
control depends on several factors including
the feedback level, input waveform and de-
lay time. The best way to become familiar
with this control is to fry it out with the other

‘ parameters on various setfings.

Many delay devices provide the ability to
| modulate the delay time. This capabllity is not
| present in the Turbosynth delay module. Itis
: found in the Modulation module described
later in this section of the manual.

|
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| Note: Delay effects inherently extend the
length of a sound, particularly at high feed-
back levels. You may wish to increase the
Length parameter in the info box to compen-
sate for this. If you have Dynamic length
based on parameters selected in the Parame-
ter Manager the length will automatically be
adjusted when you edit the delay time or
feedback.

The Pitch Shifter module accepts one input
and transposes the pitch of the input signal.

There are only three slider conftrols in this
module's window. The coarse control shiffs
the pitch of the input signal by as much as
two octaves up or down in semitone incre-
ments. The fine control shifts the pitch by as
much as 50 cents (one half of a semitone) up
ordownin 1 cent increments,

The Mix control defermines the relative levels
of the transposed and unaffected signals. This
allows you to create detune effects with a
single sound source. A mix value of 100% pro-
duces only the transposed signal at the out-
put. A mix value of 50% will combine the origi-
nal signal and the pitch shifted signal in equal
proportions.

Note: Shifting the pitch of a sound alters the
sample length needed to fully represent the
output signal. For example, dropping the
pitch by one octave doubles the number of
samples. When raising the pitch, you may
wish to change the Length parameter in the
info box to compensate for the reduced
sound length, or enable the Dynamic length
based on parameters option in the Parameter
Manager.
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sdulator Module

= Modulator-1
v fl Amount: Mix: Type:
b AM oFM  PM
i EZZEE Input:
if ®0sc-1
Osc-2
S
Modulator:
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78%
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The Modulator module accepts up to two
inputs and modulates one of the input signals
with the other input signal. A single input can
also be used to modulate itself,

This module provides the ability to control
regular variations in the frequency or ampli-
tude of one module's sound data with the
signal from another module. The ability to
perform Amplitude Modulation (AM), Fre-
quency Modulation (FM) and Pitch Modula-
tion (PM) allows this module to be used in a
wide range of applications.

You might wonder what the difference is be-
tween PM and FM. Although the words "pitch”
and "frequency" are fairly synonymous, these
types of modulation are applied differently in
Turbosynth. FM is best suited for creating tim-
bral changes by using a high frequency
modulator. PM is best suited for low frequency
control over pitch (e.g. vibrato). AM can be
used for low frequency tremolo effects or
timbral variations when a high modulating
frequency is used.

This module has two slider controls. The
Amount slider determines the intensity of the
modulating signal's effect. The Mix slider con-
frols the wet/dry mix. The type of modulation
is selected by clicking on one of the three
options (AM, FM or PM) below Type: (a dot will
appear to the left of the currently selected
modulation type). The names of the modules
connected to the Modulation module's inputs
are listed below Input: and Modulator:. To
select which module acts as the input (carrier)
and modulator, click on its name below the
desired function. You can also induce self-
modulation by selecting the same module to
perform both functions.
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Pitch modulation can be used to produce the
chorusing effect commonly achieved using
delay time moduiation. Select PM and use an
Oscillator at a frequency of 4 to 5 Hz as the
modulator. The mix control should be set
somewhere between 20% and 80% to obtain
the chorusing effect. You can vary the wave-
form within the Oscillator and perhaps send ifs
| signal through an Amplifier Envelope before it
is used as the modulation signal. Modulating
a sample with a waveform (or vice versa) can
| also produce some very inferesting results.

The Waveshaper module accepts one input
and provides a unique type of processing. To
best understand this module, let's review some
digital audio theory:

Digital audio is stored as a series numbers.
Each number represents the instantaneous
amplitude, or level, of the sound at a point in
time. These numbers fluctuate around center
value that we call 0% of scale. The maximum
excursions on either side of our center value
are labeled +100% and -100%.

The Waveshaper provides a means of modify-
ing the instantaneous level values in the sound
buffer in a regular (or not-so-regular) manner.
It alters the shape of the input signal with what
is known as a fransfer function.

The main portion of the Waveshaper window
consists of one horizontal scale across the bot-
tom and one vertical scale along the right
edge of the window. Each scale measures -
100% to +100%. The horizontal scale repre-
sents the instantaneous level values of the
input signal. The veritcal scale represents the
level values of the output signal. In essence,

| each input value gets remapped 1o a new

I output value,
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Clicking on one of the eight small preset icons
in the palette brings a line of a certain shape
into the window. The Waveshaper takes each
level value in the input signal, finds the point
on the line directly above that level value in
the input scale and replaces the input value
with the value appearing on the output scale
directly to the right of that point on the line.
This line represents the transfer function.

For example, a straight line from the lower left
comer o the upper right corner of the win-
dow allows any signal to pass unaltered. Any
single piece of sound data at -100% would be
passed on at -100%. A value of +100% would
remain at +100%. The same is frue for all the
points of sound data. This is the first preset
shape in the window's palette.

On the other hand, a straight line from the
upper left corer to the lower right cormer of
the window would shift the phase of the input
signal by 180 degrees. All data points at
-100% would be passed on at +100% and so
on. Other shapes appearing in the main por-
tion of the window alter the input wave in
many different ways.
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Stretcher Module
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i The presets include several regular shapes

| and one icon that generates random shapes

l each time it is selected. Once a preset is se-
lected, it can be altered in a variety of ways.
The modifier icons appearing below the pre-

] sets in the paletfie alter the shape by stretch-
ing, flipping, and bowing. In addition, the last

| two modifiers are used to randomize and

| smooth out the individual points along the

transfer function curve.

Like the Waveform window within the Oscilla-
tor module, the pointing tool in this window is
a pencil. This allows you to draw any transfer
function curve you like. You can use it to alter
only parts of a preset curve or to draw an
entirely new one. The smoothing modifier can
be used to smooth out any rough areas of a
freehand curve. The eraser re-establishes the
diagonal line that has no effect on the input
signal wherever it is used.

The Stretcher module accepts one input and
and stretches its duration. The input signal is
stretched by isolating small sections of the
sound and duplicating them. The frequency
parameter detemmines the size of these sec-
tions. If the frequency parameter matches
the pitch of the input signal, time expansion
with minimal distortion will occur. If the fre-
quencies don't match, amplitude modulation
effects will occur. At times, these amplitude
modulation effects can be very interesting.

This is similar fo extending a section of the
| sound in the Sample module. Once the sec-
tion has been copied a number of times, the
| loop points are shifted and the process is re-
peated. This continues until the end of the
module's sound buffer is reached.

|
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The Coarse and Fine frequency controls are
used to specify the resonant frequency of the
module. This defermines the length of the
loop that moves through the sound data. Use
these controls to tune the module to the
sound you are stretching. For example, if the
input signal is at a frequency of 440 Hz, the
Stretcher should be tuned to 440 Hz. The fre-
guency controls can also be used to add
pitch to an unpitfched sound such as a drum.

The Predelay control specifies the amount of
time (up to 1 second) at the beginning of the
input signal that will remain unaffected by the
Stretcher. For example, if the predelay is set
at 200 ms, the Stretcher will begin affecting
the signal after its first 200 ms has passed. This
allows the stretched signal to refain ifs original
attack characteristics.

Amount determines the amount of stretching
that occurs. At the minimum value of 0, the
loop moves very quickly through the sound.
The resulting sound will be very similar fo the
original input. As the amount increases, the

' loop moves through the sound more sfowly,

copying the looped section several times and

| strefching the signal more significantly. At a

value of 100, the loop moves very slowly
through the sound resulting in a very slow tim-
bral evolution.

Note: By definition, the Stretcher module
lengthens a sound. This means that the out-
put signal will be longer than the input signal.
You may wish fo increase the Length parame-
ter in the info box to compensate for this. If
you have Dynamic length based on parame-
ters selected in the Parameter Manager the
length will automatically be adjusted.

Section 4 - Using Turbosynth (Part 2)
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If you want 1o determine the fundamental
frequency of a sample, set the loop markers in
the Sample module and check the loop fre-
quency in the info box. Try to create the short-
est possible loop that produces the proper
pitch. Set the Stretcher fo this frequency.

The Resonator module accepts one input and
is used to enhance certain frequencies in the
harmonic spectrum of the input signal, much
like a delay module set to short delay times
with feedback. You'll notice that the Resona-
tor window is very similar to the Delay window.

The Coarse and Fine frequency controls spec-
ify the resonant frequency of the module. This
also determines the delay time. For example,
a resonant frequency of 1000 Hz is equivalent
to a delay fime of 1 ms. The Amount control
sets the level of resonance, or feedback level,
of the module. The Polarity control is similar to
the one in the Delay module. Its effect de-
pends on several factors. The best way to
become familiar with this conftrol is to experi-
ment with it. The Mix control determines the
wet/dry signal mix.

Note: Resonance effects inherently extend
the length of a sound, parficularly at high
feedback levels. You may wish to increase
the Length parameter in the info box to com-
pensate. If you have Dynamic length based
on parameters selected in the Parameter
Manager the length will be automatically
adjusted.

If you want 10 resonate the sound from @
Sample module and are unsure of the fre-
guency setling you should use, set the
extension markers in the Sample module and
check the loop frequency in the info box. Set
the Resonator to this frequency.

Section 4 - Using Turbosynth (Part 2)
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The Mixer module accepts up to 32 inputs
and combines the input signals into a single
output. This module can be used at any point
within a patch to combine the sounds of sev-
eral other modules.

The name of each module connected to the
input of the Mixer and a corresponding slider
control appear in the Mixer window. These
sliders are used to specify the level of each
input signal from 0% to 100%. The scroll bar at
the bottom of the window allows you to ac-
cess all the sliders if many modules are con-
nected to the Mixer.

Note: Like any Turbosynth module, the range
of amplitude values in the Mixer sound buffer
is finite. It is conceivable that the peaks of
several input signals might coincide, resulting
in an amplitude that exceeds the maximum
allowable value. It is for this reason that the
mixer inputs are attenuated to prevent clip-
ping and ofher distortions. As a result, the
Mixer's output signal could be at a low overall
amplitude. If the output level seems low, use
the Normalize option in the Mixer's info box to
ensure that the highest peaks in the output
signal reach full amplitude.

The Pitch Envelope module accepts one input
and varies the pitch of the input signal over
time.

Many hardware synthesizers provide pitch
enveloping as a way of creating expressive
effects in patches, by using subtle (or not-so-
-subtle) variations in an oscillator's pitch. The
Pitch Envelope module functions in much the
same way as conventional pitch envelopes,
but offers a greater degree of conftrol, due to
its multiple breakpoint envelopes.
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The Pitch Envelope module allows the pitch of
the input signal to be continuously varied over
a range of plus or minus one octave. For con-
venience, the Pitch EG's Envelope window
has scale markings at plus and minus 1, 4, 7,
and 12 semitones. The center line represents
zero pitch shift. Please note that this scale is
non-linear. Although the scale markings are
equally spaced, they do not represent equally
spaced differences in pitch. This permits fine
pitch adjustment close to the original pitch
(for chorusing/detuning effects), while allow-
ing a wide range of overall adjustment,

Eight small Preset Envelope icons appear in
the center of the palette in the Envelope win-
dow. To replace the current envelope with
any of these preset shapes, simply click on its
icon.

The Envelope Modifiers icons affect the cur-
rent envelope in a variety of ways. Clicking
on a Modifier's icon shifts the entire envelope
in the direction indicated by the Modifier's
icon. Repeatedly clicking on the icon will
continue to shift the envelope.

The top two modifier icons affect the overall
amplitude of the current envelope. Click on
the icon with the up-pointing arrow to in-
crease all envelope breakpoints proportion-
ally; while the down-pointing arrow decreases
all envelope breakpoints proportionally.

The middle two modifier icons affect the over-
all length of the current envelope. Click on
the icon with the left-pointing arrow 1o shorten
all envelope breakpoints proportionally. Like-
wise, the right-pointing arrow will lengthen all
envelope breakpoints.
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The botfom two modifier icons compress or
expand the amplitude of the current enve-
lope with respect to the center of the graph.
Click on the icon with the inward-pointing
arrows to compress the current envelope. This
will reduce the amplitude range, while retain-
ing the overall shape of the envelope. Click
on the icon with the outward-pointing arrows
to expand the current envelope. When using
the Pitch Envelope these modifier increase or
decrease the "depth” of the effect.

The Noise Oscillator module accepts no inputs
and produces various types of noise as a
sound source in a Turbosynth patch. Although
static noise usually isn't desirable, processing
noise with Amplitude Envelopes, Filter Enve-
lopes, Resonators and other modules can be
very effective. The Noise Oscillator can be
thought of as a randomized sine oscillator.

The amplitude and freguency of the sine
wave can be randomized independently of
each other.

The Coarse and Fine conftrols specify the fre-
guency of the module's noise output. The per-
ceived pitch of the noise depends on the
type and amount of noise currently selected.

Amplitude Noise is produced by rapidly vary-
ing the amplitude points of the waveform.
The amount of Amplitude Noise is controlled
by the "Amp. Noise" parameter.

Phase Noise is produced by rapidly varying
the phase of the waveform, and is controlled
by the "Phase Noise" parameter.

These two types of noise can be combined‘ in
any desired ratio. If you want to create white
noise set the frequency, amplitude noise, and
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phase noise parameters to their maximum
values. Please note that if the amplitude and
phase parameters are set to zero, the resulting
sound will not be a pure sine wave. Instead, a
low resolution sine wave will be produced.

The Time Compressor takes one input and
compresses its duration. In effect, the tfimbral
evolution of the input signal is accelerated so
that the entire sound occurs in a shorter time
period.

The Coarse and Fine parameters control the
resonant frequency of this module. If the fre-
qguency of the Time Compressor matches the
fundamental pitch of the input signal (assum-
ing the input is a pitched sound), the input will
be shortened with minimal timbral change. If
the Time Compressor's frequency differs from
that of the inpuft, or if the input is an unpitched
sound, amplitude modulation effects will ap-
pearin the sound.

The Predelay control specifies the amount of
time (up to 1 second) at the beginning of the
input signal that will remain unaffected by the
Time Compressor. For example, if the prede-
lay is set at 200 ms, the Stretcher will begin af-
fecting the signal after its first 200 ms has
passed. This allows the stretched signal to
retain its original attack characteristics.

Amount determines the amount of time com-
pression that occurs, At the minimum value of
O there is very liftle time compression. The re-
sulting sound will be very similar to the original
input. As the amount increases, the sound will

| become shorter without changing pitch (pro-

vided the frequency is set properly). At a
value of 100, the sound will be a fraction of its
original length.
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The Output accepts one input and is the final
stop for sounds on their way to samplers or 1o
disk storage. The output allows you to view
the overall waveform of the sound, place
loop markers in the sound, and perform
crossfade looping. Normally the output does
not have its own sound buffer. Instead, it gives
you a view of the module connected to the
output. However, the output does have its
own buffer when crossfade looping is enabled
(see below).

The Output window graphically displays the
sound waveform represented in the sound
buffer of the input module. In fact, you'll no-
tice a strong similarity between the Qutput
window and the Sample window. The sound
wave is not displayed in the Output window
unftil the sound buffer of the input module is re-
calculated. This is accomplished by clicking
on the speaker icon in the Output window or
the input module window. Similarly, the Out-
put display is not updated withnew data until
the input module sound buffer is recalculated.

If you notice that the peak amplitude of the
output is relatively low you may want to Nor-
malize the module which is connected to its
input,

The Output palette includes start and end
Loop markers. These loop markers are se-
lected, placed and erased in the same man-
ner as the sample module (see page 40 for
more information).

The Loop window is opened by clicking on the
magnifying glass icon, and operates in the
same manner as the sample module loop
window (see page 40 for more information).
The loop points will be saved with a sound file
and also transfered to your sampler.

stion 4 - Using Turbosynth (Part 2)
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| Unlike the Sample module, the command key
does not need 1o be depressed to hear the
loop when the sound is played.

If you are unable to find a good loop in the
sound, you may want to use Crossfade Loop-
ing. As with crossfade looping in the Sample
module you have your choice of crossfade
type and crossfade length.

Once loop markers have been placed, click
on the crossfade looping icon to display the
crossfade looping dialog box. This dialog box
allows you to specify the type of crossfade,
and the length of the crossfade.

Linear crossfades tend to work best on sounds
with decaying envelopes (e.g. pianos, gui-
tars). Equal power crossfades tend to work
best on sounds with stable envelopes (e.g.
strings, brass).

Longer crossfade lengths tend to create bet-
ter sounding loops. The crossfade length is
limited by three ranges: 1) the distance be-
tween the start of the sound and the loop
start; 2) the distance between the loop start
and the loop end; 3) the distance between
the loop end and the end of the sound. Keep
this in mind when setting loop markers, prior to
creating a crossfade loop. Also, make sure
the loop markers are aligned in the loop win-
dow.

Note: Unlike the sample module, crossfade
looping in the output should be thought of as
a mode rather than an action. Once you've
clicked on the icon and specified the para-
meters, the output will continue to crossfade
loop anything that flows info the output. If
you decide to adjust a parameter in a differ-

ent module, you don't have to worry about
63
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losing your perfect loop. When crossfade
looping is enabled a separate sound buffer is
created for the output. If there is not enough
memory to create the sound buffer, you will
not be able to crossfade loop.

Some samplers such as the Emax and FZ-1, will
not play loops if the loop end is on the last
sample point. Other samplers such as the Mi-
rage, have strict guidlines as to where loop
markers can be placed. If you transfer this
type of looped sample and find that the loop
end has been changed, it's due to this imita-
tion. Additionally, some samplers such as the
5900, DSS-1, TX16W, and S-50, will not play any
sound data which follows a loop end marker.

The values in the Output Jack info box are not
found within edit text boxes. Since the output
is a view of the module connected fo it, the
values reflect those found in the info box of
the input module. Like the Sample module,
the loop frequency identifies the frequency of
the waveform appearing between the loop
points.
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Digital sampling instruments are recally digital
audio recorders that can franspose (raise or
lower) the pitch of the digital recording.

Turbosynth creates simulated digital record-
ings ("samples”) of sounds you have designed
using modules as discussed in Sections 3 and
4, "Using Turbosynth (Parts T and 2)". Once
you have created a sound using Turbosynth, it
must be fransferred to your sampler for play-
back.

Turbosynth can create sounds for many differ-
ent samplers, and each sampler has a differ-
ent "personality”. Fortunately, Turbosynth al-
ready knows all about your sampler's person-
ality. After you select your sampler from the
Sampler menu, Turbosynth's Mac -> Sampler
function automatically converts Turbosynth
sounds into your sampler's format,

All samplers are not created equal - many
factors contribute to the overall fidelity of a
sampler, including sample rate, data format
and pitch shiffing method.

As you may recall from the discussion of spec-
fral inversion in Section 4, the sample rate is
the number of times each second that the
sampler measures the input sound. Increasing
the sample rate increases the high frequency
response. In theory, the highest frequency @
sampler can record and reproduce is one half
the sample rate (the "Nyquist”® frequency). For
example, if the sample rate is 30,000 samples-
per-second, the highest reproducible fre-
quency would be 15,000 Hertz, Actually, the
real high frequency limit is slightly lower due to
input and output filtering.

Section 5 - Sampler Personalities
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' Some samplers have variable sample rates. |
If your sampler has more than one sample "
rate, the Turbosynth Parameter Manager I
should be set fo the same sample rate as your '
sampler. If the selected sample rates are dif- I
ferent, the Turbosynth sound may play back =
at the wrong pitch. I
1
The data format is the digital recording I
method used by the sampler to record and | 1
store sounds. In general, the more bits used to |
record each sample, the better the signal-to- [ ¥
noise ratio and dynamic range. Eight bif I
linear (no digital compression) sampling pro- .
vides a maximum signal-to-noise ratio of 48 E
decibels (dB), 12 bit linear sampling has a $/N l
ratio of 72 dB, and 16 bit linear sampling has a E:
S/N ratio of 96 dB. Some samplers (such as the |
E-mu Systems Emulator Il and Emax) use vari- t'
ous data compression techniques and other I
tricks to improve their signal-to-noise ratio. ti
| Turbosynth creates 16 bit linear sound files in ) &
standard Sound Designer format. These files |
are converted into your sampler's format E
when the Mace -> Sampler function is used. |
Each sampler also uses a slightly different ti
method for transferring sound files to and from ‘.
the Macintosh. The following descriptions I
explain characteristics of each sampler that =
affect its use with Turbosynth. i

|
| *
| *
|
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Akai X7000/5700

Akai $900/5950

Casio FZ-1/FZ-10M

| The Akai X7000/S700 is a twelve bif sampler
with six separate banks of sample memory.
Each bank consists of 32768 bytes of memory,
and has a maximum sampling time ranging
from 1 second to 8 seconds depending on the
sample rate used. Since 31250 is a commonly
used sample rate, you may wish to enter it in
the Parameter Manager.

The X7000/5700 uses the loop end point as the
sound end point. Hence, sounds transferred
to the X7000/5700 may appear to be shorter
than their original size.

The Akai $900/S950 are twelve bit samplers
with maximum sampling times from 11.75 sec-
onds to 63.3 seconds depending on the
sample rate used (8900 - sampling times for
the S950 are greater). The SQ00 has a variable
sample rate ranging from 7.5 kHz to 40 kHz (up
to 44kHz on the S950). Since 31250 is a com-
monly used sample rate, you may wish to
enter it in the Parameter Manager.

The Casio FZ-1 is a 16-bit sampler with 64
sound locations. The FZ-1 has three sample
rates: 36 kHz, 18 kHz and 9 kHz. Since 36000 is
a commonly used sample rate, you may wish
to enter it in the Parameter Manager.

The FZ-1 will not play a loop if the loop end is
on the last sample point of a sound.

In order 1o transfer sound data between the
Mac and the FZ-1, the following conditions
must be satisfied:

e Match the FZ-1 MIDI basic channel with the
Turbosynth MIDI channel.

¢Set MIDI receive to 'BASIC', and set Select

Device to 'MIDI".
67
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oSet the arrow mark 1o (REMOTE MODE)

If a MIDI communication problem occurs, the

FZ-1 may display an error message. If this oc-

curs, you must press the Up cursor button. This
[ will clear the message and enable MIDI,

The E-mu Systems Emax uses a special non-
linear 8 bit data format that provides a signal-

to-noise ratio comparable 1o 12-14 bit systems.

The Emax has several sample rates ranging
from 10kHz to 42kHz. The Emax has a total
sampling time of 17,2 seconds at the default
sample rate of 27777 Hz. Since 27777 is a
commonly used sample rate, you may wish to
enter it in the Parameter Manager.

Turbosynth transfers sound files to the Emax
using a RS-422 interface cable (available from
Digidesign). If you cancel a sound file transfer
between the Mac and Emax, the Emax may
take up to 1 minutfe to recover.

To use Turbosynth with the Emax you will need:

e An Emax with version 3.2 (or higher)
software.

oThe MIDI out connector on the Emax
selected as Out, not Thru.

The E-mu Systems Emulator Il uses a special
non-linear 8 bit data format that provides a
signal-to-noise ratio comparable to 12-14 bit
systems. The Emulator Il has a total sampling
time of 17.2 seconds at a sample rate of
27777 Hz. Since 27777 is the sample rate, you
should enter it in the Parameter Manager.

68
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| Turbosynth transfers sound files to the Emulator
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Il using either of the Macintosh RS-422 serial
ports (the printer or modem port). The RS-422
interface transfers sound files very quickly
(500,000 bits per second) - nearly 17 times MIDI
speed. Since the Emulator can't receive
sound files via MIDI, the RS-422 interface cable
is required for for sound fransfers. To use Tur-
bosynth with the Emulator Il you will need:

¢ An Emulator Il with version 2.3 (or higher)
internal software ROMs.

eEmulator Il performance disks with version
2.3 (or higher) software.

s An RS-422 interface cable (available from
Digidesign).

The E-mu Systems Emulator lllis a 16 bit sam-
pler. Since 44100 is a commonly used sample
rate, you may wish to enter it in the Parameter
Manager.

Turbosynth fransfers sound files to the Elll using
the SCSl interface. If your Mac does not in-
clude a SCSI hard disk, you must own an SCSI
terminator. The use of 'generic' ribbon cables
is not recommended because of the potential
for communication problems. For best results,
use Elll system software version 2.0 or higher.

Use the follow guidelines for SCSI connections:

o|f your Mac setup does not include an
internal SCSI hard drive or any external
peripherals, connect an SCSI terminator to
the Elll, then use an SCSI cable to connect
the terminator o the Mac SCSI port.

Section 5 - Sampler Persor.alities
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o If your Mac setup includes an internal SCS!
hard drive and no other SCSI peripherals,
use an SCSI cable to connect the Elll to the
Mac directly.

o|f you have an extermnal SCSI hard drive or
other SCSI peripherals, daisy-chain your
SCSI drive and peripherals to the Mac.
Without using an SCSI terminator, connect
the Elll to the last SCSI peripheral,

Once the connections have been finalized,
you should use the following power-up se-
guence:

1) Turn on the Elll and verify that its hard disk
SCSIID is set to a value other than zero.

2) Turn on any other SCSI peripherals.

3) Turn on the Macintosh. Once Turbosynth
has been launched, select Emulator lIf from
the Sampler menu.

Sounds can now be fransferred to and from
the Elll by using the File menu transfer com-
mands or the Mac -> Sampler icon. A dialog
box will indicate the status of the Elll's voices.
Samples cannot be fruncated at or during the
transfer, so Elll memory management by the
user is important. When powering down the
system be sure 1o reverse the above order.
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Multisampler
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The Ensonig Mirage and the Mirage Multisam-
pler are both 8 bit samplers that can store
about 4.4 seconds of digitized sound (2.2 sec-
onds per memory half) at a sample rate of
29412 Hz. Since 29412 is a commonly used
sample rate, you may wish to enter it in the
Parameter Manager.

The Mirage should be booted with MASCOS
version 2.0.

If the Mirage does not have enough free
sound memory to store a sound file, a dialog
box will appear to wam you that the file is too
large. You have three options - you can Can-
cel the transfer, Truncate the file, or Extend the
sample's memory.

Section 5 - Sampler Personalities
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The Ensoniqg EPS is a 13-bit sampler that can
hold up to 8 "instruments" of up to 127
‘wavesamples” each. The maximum sampling
time is limited only by the sampling rate and
the amount of memory available. All of the
EPS’s memory can be dedicated to one
wavesample, or it can be divided among
wavesamples. The EPS offers manyf sampling
rates—from 6.25 kHz up to 52.1 kHz. Since
36800 is the optimized sample rate, you may
wish to enter it in the Parameter Manager.

Turbosynth includes both MIDI and SCSI drivers
for the EPS. If the EPS is equipped with an SCSI
port, you cannot use the MIDI driver.

In order to transfer sound data between the
Mac and the EPS, the following conditions
must be satisfied:

e You must use a startup disk with EPS OS 2.35
or higher.

¢ MIDI Sys-Ex must be enabled on the EPS.
From the EPS front panel, use the Edit-MIDI
button sequence to turn MIDI SYS-EX on.
| Use Command-System to SAVE GLOBAL
PARAMETERS if you want to make this a
permanent change on your starfup disk.

¢ A system disk should be left in the EPS’s
{ disk drive the first time a sound transfer is
done so the EPS may read system
information.

If you plan to use Sound Designer Il with the
SCSlinterface on the EPS and your Macintosh

| setup does not include an SCSI hard disk, you
must own an SCSI terminator.

|
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| First, connect the EPS to the Macintosh using
conventional MIDI connections: two MIDI
cables—one for each direction—between the
j EPS and a Macintosh MIDI interface.

| Next, making sure the EPS, Macintosh, and alll
other SCSI peripherais in your setup are pow-

( ered off, connect the EPS to your Macintosh
setup using a standard Macintosh SCSI cable:

¢ |f your Macintosh setup does not include an
infernal SCSI hard drive nor any external SCSI
peripherals, connect an SCSI terminator to
the EPS, then use an SCSI cable to connect
the terminator to the Macintosh SCSI port.

¢ If your Macintosh setup includes an internal
| SCSI hard drive and no other SCS
peripherals, use an SCSI cable to connect
the EPS to the Macintosh directly.

¢ If you have an external SCSI hard drive or
other SCSI peripherals, daisy-chain your SCSI
drive and peripherals to the Macintosh.
Without using an SCSI terminator, connect
‘ the EPS to the last SCSI peripheral.

Once the connections have been made, you
should use the following power-up seguence:

| ¢ Turn on the EPS first. From the System page,
choose an SCSI ID that is unique within your
SCSI network (the Macintosh is ID 7 and the
standard Macintosh SE intfemal hard disk is
ID 0 - the EPS defaults to ID 3).

‘ ¢ Turn on any other SCSI peripherals.
¢ Turn on the Macintosh.

When powering down the system, simply re-
I verse the above order.

Section 5 - Sampler Personailities



org DSS-1

org DSM-1

Make sure the SCSI ID number matches the
EPS SCSI ID in Sound Designer II's Sampler dia-
log.

If the EPS ever displays an error conditfion, it is
recommended that you power down the
system and reboot all SCSI devices.

The Korg DSS-1 is a twelve bit sampler with a
maximum sampling time ranging from 5.5
seconds to 16 seconds, depending on the
sample rate used. The DSS-1 has four sample
rates available: 15625 Hz, 23810 Hz, 31250 Hz
and 47620 Hz. Since 31250 is a commonly
used sample rate, you may wish to enter it in
the Parameter Manager.

If you sample sounds using the 47620 Hz
sample rate, you must do the following before
fransferring those sounds to the Macintosh:

e Enfer the Multi Sound mode on the DSS-1.
e Select Function #3.

¢ Exit the Multi Sound mode.

The Korg DSM-1 is a twelve bit sampler with a
total sampling time ranging from 22 seconds
10 64 seconds, depending on the sample rate
used. The DSM-1 has four sample rates avail-
able: 15625 Hz, 23810 Hz, 31250 Hz and 47620
Hz. Since 31250 is a commonly used sample
rate, you may wish to enter it in the Parameter
Manager.

Waming: The Programmer General has deter-
mined that Non-terminated MIDI cables con-
nected to the DSM-1 MIDI Thru are hazardous
to communications.

:ction 5 - Sampler Personalities
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Roland S$-10, $-220

Roland S-50

| The Roland $-10, 5-220 and MKS-100 are very
similar. In fact, the MIDI messages used to
tfransfer samples are identical. This description
will use "S-10" to refer to all three.

The 5-10 has a total sampling time of 4 sec-
onds at its 30 kHz sample rate, or 8 seconds at
its 15 kHz sample rate. Since 30000 is a com-
monly used sample rate, you may wish to
enter it in the Parameter Manager. If you
would rather use the lower sample rate, enter
18000 in the document information box.

To use Turbosynth with the S-10 you will need
to furn the 5-10's MIDI System Exclusive pa-
rameter On, and turn Active Sensing Off,

The Roland $-50 is a twelve bit sampler with
total sampling time of 14 seconds at its 30 kHz
sample rate, or 28 seconds at its 15 kHz
sample rate. Since 30000 is a commonly used
sample rate, you may wish to enter it in the
Parameter Manager.

Turbosynth is not able to allocate memory in
the S$-50. Hence, you may find that the desti-
nation in the $-80 is either foo small or too
large for a Turbosynth sound you wish to send.
If the Turbosynth sound is oo large you will be
given the option to truncate the sound. An-
other option is fo create a new sample within
the S-80 of a more suitable size.

To use Turbosynth with the $-50 you will need
to tumn the S-80's MIDI System Exclusive pa-

| rameter o 'On'. You must use system 2.0 or

| higher software.
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i The Roland $-550 is a fwelve bit sampler with . available but, as yet, not sampled. A 'non-
land S-550 P
total sampling time of 28 seconds at its 30 kHz 2 9 existant’ sound is one that cannot be created
sample rate, or 56 seconds at its 15 kHz s on the sampiler (e.g. "sound 33" in a sampler
sample rate. Since 30000 is @ commonly used = that only holds 32 sounds).
sample rate, you may wish to enter it in the
Parameter Manager. & q Additiondlly, there is nO way to determine
= from the Macintosh whether or not a sampler
Turbosynth is not able to allocate memory in = o } will accept a sound. SombeTsomplers will allow
the $-550. Hence, you may find that the desti- ‘ you to replace a sound, but not fransfer to an
nation in the $-550 is either too small or too & | unoccupied location. Other samplers allow
large for a Turbosynth sqund you wish to s_end. 5 both the rep!ocemen‘r of a sound as well as
If the Turbosynth sound s too large you will be = « the allocation of a new sound location. If
given the option to tfruncate the sound. An- Turbosynth attempts fo fransfer to a less coop-
other option is to create a new sample within - erative sampler, an error message may ap-
the $-550 of a more suitable size. E 9 pear.
To use Turbosynth with the $-550 you will need E g I In general, sound transfers with an MMA SDS
to tum the $-550's MIDI System Exclusive pa- sampler will go smoothly if you are aware of
rameter to 'On'. You must use system 2.0 or E _il the limitations of your sampler. You should
higher software. ‘ know how many sample locations are avail-
E g able in your sampler, and whether your sam-
‘ pler will accept transfers to unoccupied
|mple Dump The Sample Dump Standard (SDS) was devel- | o “ sample locations.
andard (SDS) oped to facilitate the transfer of sampled |
sounds between different samplers. As of the E 3
printing of this manual, samplers that sup- ' |
ported SDS included the Sequential Prophet E: 9
2000/2002, Sequential Studio 440 (with ROM I
2.20 call (415) 821-6613), Dynacord ADD-T, E . r
Yamaha TX16W, Akai S1000, Forat F-16, and :
Simmons SDX. There are two different flavors E |
of SDS: 12-bit and 16-bit. Select the menu |
command that corresponds to your sampler. E | a
[}
Although the SDS was meant to be a stan- | .
dard, there are a few "gray areas”, and differ- N L ]
ent manufacturers may have implemented | 1
SDS in slightly different ways. For example, | |
there is no way of knowing (via MID!) whether I
| asound is 'not sampled’ or 'non-existant’. A S |
| 'not sampled' sound is a sound location that is | ]
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User Tips | Turbosynth is @ program with the potential for
by Peter Freeman creating a vast array of sounds. Because of
(Peter is a bassist/synthesist ‘ this capability, however, it's possible that the

based in New York City. He has | Program might appear rather daunting to
worked with such artists as: John | some first-time users. For this reason, we feel it
Cale, L. Shankar, Pierce Turner, may be valuable to offer some suggestions on
Richard Horowitz and Sussan interesting ways that Turbosynth's power can
Deihim. In this secfion of the be used. To this end, we present the Tur-
manual he shares some fips and | osynth User Tips section: a collection of
ideas for creative sound design | jqegs, hints, tips and tricks which should (we
using Turbosynth). hope) enlighten the Turbosynth neophyte on
just what can be done with this new tool. This
chapter is divided up into three catagories:
module specific techniques, general tech-
niques and sampler fechniques. This chapter
is intended to offer ideas which will hopefully
inspire you to create your own applications for
the program, and generally get your creative
juices flowing. Have fun, and above all, ex-
periment!

Oscillator Module Often it is difficult to make a connection be-
tween what a waveform looks like and what it
Atfew words | sounds like. Although we can describe some-
on Waveforms | thing as "dirty" sounding we might not know
how to create it. However, there are a few
general observations that may aid you in
achieving particular results: Waveforms with
closely spaced harmonics tend to sound
"dirty", often with jagged waveforms; free-
hand drawing tends to produce these types
of sounds. "Clean" waveforms tend to have
widely spaced harmonics. "Clean” waveforms
tend to have smooth curves. "Nasal” wave-
forms tend to have a cluster of prominent,
closely spaced harmonics. Waveforms with
few zero-crossings have strong lower harmon-
| ics and/or fundamental.
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cross loop). Next, use the "save loop as wave-
form" command in the File menu, and open |
the new waveform into your oscillator using L . . L2
the "file cabinet" icon. When using this tech- | sampled waveforms; whils this function is not
nique, the best results are generally achieved I true "time varying resynthesis, it is quite ca-

if the atfack of the oscillator is followed | pable of producing interesting results.

the File menu) as well as purely synthetic ones.
Experiment with analyzing and altering

Ei N
£ N
| Those who have used the Softsynth time slice | = quickly (within 50-100 msec) by a conven-
ftsynth Users Y )
For Softsy mode may find the harmonic mode of the = j fional syrﬁhesaed queform onq/or wave
oscillator to be very familiar. This oscillator | forms. This way the high harmonics of the
mode may be used to create a similar class of i L somelle-lcigp WC’;’el'f.orm are qt_chkIyﬁfodTed out,
sounds; e.g. clean, transparent and precise. . creating the metaliic, percussive effect.
However, due fo its greater resolution, the ﬁ' j Wavef . o ) ¢ Hi . di
oscillator harmonic mode allows for the crea- ‘l 3 avelorm mixing WQS ;?ocrgr;l?slfri rgirxcsrg\? e'::f‘; (;Ji?fgléi,rs %rlgﬁ éng
fion of an even wider variety of possible ! . . .
sounds using Softsynth like ‘rechniqu'es. Think of _ | ] |(v|s'i?(g'reo?/gxii@é?;?gg{gﬂg’ggﬁ%fjssli?%gr
\gov_ﬁf?rms pl,?cid olongT‘rheYduro’rlon of an ‘i L] to those found on conventional hordwc':lre
scillator as "timbre events'. You may place ) . .
cirony oo il ondre -3
program will crossfade between them in ex- ; ) A .
. . " " : . t, decide what
acty thosamo way Sofynih doos Tnemdor it 3
difference here is that unlike Softsynth, there is | final result. and creo‘reé group of "compo
no master amplitude envelope. You must use ‘, 3 . . . .
o . ) ! " bine to
an additional Amplitude Envelope module in nent" oscillators Wh'Ch you can com
. mpl -
Turbosynth to replace the master envelope. 1! 3 gﬁgécfgré?e%?grgiosgﬁg%ﬁ %g cl'?oeroecx‘rer-
Also, If you have favorite Softsynth timbres, | isTicTshoderiongle Orl‘éj So\?(/‘roo‘rh \’."O\;es uﬁ%”? fhis
synthesize them into Sound Designer sound E 3 ?nee boeir’wyocuomo%sergoofiosirecig ?ric?ricaeo ors,
_files (if you haven't already), and open them l wave ‘rhg oTherpcon‘roinin o%ow‘roof% wave
into Lu_rb%syn‘rh Sample mod(;JI_es. Whgn pT(oc— E 3 and p'o’rch both info a Mixger ’
essed in the program or used in combination '
with Turbosynth's own oscillators, they can [ ] .
become an effective starting point for new _ Sgﬁf Téoslé\r/eeo,r%g ngrggg;ﬁg \t/s)/loec;g% ‘rrg%»i/sk
sounds. .'i 3 for later use. To do this, convert the Mixer to a
: ; le, create a short loop in the sample,
Getting a | If you need to create a sharp, metallic atfack \ 3 samp ) r
Percussive Attack | in an oscillator, fry using a waveform from @ | and use ’rhe save loop as waveform® com-
complex sampled sound, such as a piano. = 3 mand. This will create a waveform document
Using ,rhhe l0op mcjr:(erél Cr.eoTe a sfh,r?]” loop | | which can be used in new oscillators.
somewhere near the beginning of the sample. ; ] . ‘
The loop should be erratic so that it will con- ‘Zl 1 Samplgd waveforrp fhe harmonic mode of the oscf:lllo’ror can F%
tain many high harmonics (not a smooth zero- = 9 analysis/resynthesis Sg%iﬁg?sii‘g%i‘éogf%%\’eefo?mso(ggﬂ ii
L |
14
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Turbosynth's Delay module functions in much
the same way as conventional hardware
DDLs, and can be employed as such, allowing
more "polished" sounds to be created without
leaving the program. Many DDL effects can
be replicated in Turbosynth with pleasing re-
sults. Here are a few of them:

Adding a touch of subtle "doubling" delay
(typically less than 100 mSec) can give added
extra dimension to most sounds, and can help
accentuate sharps attacks. Experiment with
the wet/dry mix to vary the amount of effect,
and synthesize a few versions of the finished
patch at different frequencies to minimize the
undesirable effects of extreme pitch shift
across the keyboard.

As with all of Turbosynth's modules, the num-
ber of possible delays in a patch is limited only
by the available memory (here again, a
Macintosh with at least 2 megabytes of RAM is
stfrongly recommended!). This allows the pro-
gram to simulate some elaborate delay-
based effects that exist in conventional hard-
ware signal processors, such as multitap de-
lays and reverb. For the uninitiated, a mutti-
tap delay is a conventional digital delay line
with one important difference: instead of pro-
ducing only one delayed signal, it can pro-
duce multiple delays (each at a different
time) relative to its input- that is, there are
“taps" placed at different positions along the
delay line, each capable of producing one or
more repeats. Most hardware-based multitap
delays contain between two and six taps.

In the context of Turbosynth, this type of effect
is very easy to simulate using multiple inde-
pendent delay modules, (each receiving the
same input signal), set to different delay fimes
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Reverb Simulation

Comb Filtering
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| and mixed together using a Mixer module.
The major advantage of creating this effect in
Turbosynth is that the user can go much fur-
ther than most hardware systems. For ex-
ample, each separate "tap" (delay module) in
a "multitap” patch could be further processed
using any of the other modules, or combina-
tions thereof, before being paftched to the
Mixer with the others.

Another example of a delay-based effect
can be found in the "Cheez-verb" patch on
the Sample Files disk supplied with the pro-
gram. This patch uses multiple Delay modules
to process a single drum machine "rim’
sample, each one set to a slightly different
delay time, with a fairly large amount of feed-
back. The first Delay in the chain has a much
greater delay time than the others, to simulate
the "pre-delay" effect that sometimes exists in
large, reverberant spaces. The outputs of dll
of the Delays are then combined in a Mixer.
Because natural reverb is composed of many
discreet echoes, the result is an approximation
of the real thing. Each of the Delays simulates
the behavior of individual "reflections” in an
imaginary room. In reality, it would be imprac-
fical fo accurately reproduce natural reverb
using only delays because of the extremely
high number of possible reflections that exist in
a reverberant space. Nonetheless, tech-
niques like the one described above can yield
interesting results. Experiment modifying this
patch using other modules.

With delay times less than about 20 ms, a de-
lay does not create discrete echoes, but
rather, phase reinforcement or canceliation
effects. To create these type of effects you
should probably use the resonator. The reso-
nator is optimized for creating short delay
type effects.
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Turbosynth's filter envelope module provides
an effective means of achieving conventional
(and not-so-conventional) lowpass filtering
effects. Here are a few useful applications:

In patches with multiple Oscillators or Sample
Modules, experiment with contrasting filtering
effects on each one. Try using simultaneous
slow and fast filter envelopes, as well as com-
bining simple envelope curves with more con-
voluted ones.

The Filter Envelope can also be useful for re-
moving unwanted brightness in a Sample
Module or an Oscillator. Use a constant enve-
lope (i.e. a straight line with a single break-
point at its beginning). The height of the line in
the window determines the "cutoff' fre-
guency.

As with all the envelope-based modules, the
breakpoint oriented design of Turbosynth's

| filter envelope allows far more precise control

84

over the contour of an envelope than the
conventional ADSR design found on most
hardware synths. Take advantage of it! Many
subtle nuances are possible when using many
breakpoints in the curve of an envelope.

Also, LFO effects can be simulated by creat-
ing an envelope that continuously oscillates
between two levels.
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Pitch Envelope
Module

Chorusing

Horn Blips
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This module is extremely useful for adding ex-
pressiveness and character 1o most sounds.
Slight variations in pitch may sometimes play
subtle tricks on the ear, which can help make
the "electronic" quality of synthesized sounds a
little less glaring. As an example, fry patching
an Oscillator Module through a Pitch Enve-
lope containing very small (less than a semi-
tone) dips and peaks in its envelope.

Patch a Sample module or an Oscillator mod-
ule through a Pitch Envelope containing small
dips and peaks in its envelope. Patch both
the Pitch Envelope's output and a direct out-
put from the Oscillator info a Mixer. Due 1o
changing phase relationships between the
original signal and the enveloped signal a
sweeping filtering effect will occur.

The Pitch Envelope is also effective for imitat-
ing some of the characteristics of acoustic
instruments. For example, one way of adding
realism to brass-instrument sounds is 1o create
a small "blip" at the sound's aftack, using the
envelope window. To do this, place a break-
point at the very beginning (extreme left) of
the window, below the zero line at between -
1 and -12 semitones. Then, place another
breakpoint about 10 mSec later, on the zero
line. The result should be a slight but nofice-
able upward pitch bend during the attack of
the sound. This effect imitates the initial pitch

| fluctuations that are characteristic of many
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brass instruments. Experiment with placing
additional breakpoints on either side of the
zero line.
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Although amplitude envelopes are common
place (virtually every synthesizer ever made
has them), there are a few unusual ways in
which they can be employed which are worth
covering here:

Open one of your favorite samples (preferably
one with wide variations in amplitude) into a
Sample Module, then remove its amplitude
envelope using the Envelope Extraction func-
tion. The resulting sample should keep a con-
stant level throughout its duration. Next,
patch it through an amplitude envelope, and
re-envelope the sample. Try a few different
envelope contours, especially ones which
differ greatly from the sample’s original shape.
This process can give standard acoustic
sounds an unusual guality.

The "Convert to Envelope" function allows you
to convert a Sample module into a amplitude
envelope. The the amplitude envelope from a
sample module can then be applied to an-
other Sample module, Oscillator or whatever.
When the envelope data from a sample is
applied to an Oscillator, the Oscillator will as-
sume the amplitude characteristics of that
sample. The Osciliator's output can then be
mixed with the original sample using a Mixer,
to create subtle "shading” effects.
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General Rules
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The Waveshaper can be very effective as a
"distortion generator” which can give a sound
some "grit". Additionally, the amount and type
of distortion will change with amplitude
changes in the input. Since distoriion adds
additional harmonics to a sound, it is a good
idea fo connect a simple sound (i.e. sounds
with few harmonics) to this module. This way
you can produce a sound that can go:from
one harmonic extfreme to another when am-
plitude changes occur. Often an enveloped
sine wave is effective as an input for the
Waveshaper.

The following is a good exercise to familiarize
yourself with the Waveshaper. Create an
Oscillator containing a sine wave, then patch
it through an amplitude envelope module
and give it changes in amplitude. Patch the
Amplitude Envelope Module to a Wave-
shaper, and experiment with using the differ-
ent preset shaping functions and modifiers to
see how they effect the sound. Experiment
with other Oscillator waveforms and Ampli-
tude Envelopes. Also, open the "Waveshaper
example" patches on the Sample Files disk
and examine them. Experiment with chang-
ing the shaping functions, by trying the differ-
ent modifier icons, and by drawing your own
shapes in the graph with the "pencil” tool.

Because the Waveshaper's effect is deter-
mined completely by the shape of the graph
in its window, it is important to have a general
feel for what type of results will be produced
by it. Generally speaking, the more jagged a
shaping function is, the more high frequency
distortion it will produce. If a waveshaper
does not map an input level of zero to an
output level of zero, sounds will tfend to have
DC offset. Also, the waveshaper can greatly
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waveshaping function does not utilizes the full
vertical displacement of the graph the sound
will be compressed.

The Waveshaper tends to work well in combi-
nation with other modules. Patching its output
into Resonators, Stretchers and Delays can
create unusual effects which can be great for
processing Samples. Some particularly inter-
esting candidates for this kind of processing
are vocals, speech, strings, and percussion.

For some interesting "fuzz" effects, experiment
with the boftom-left modifier icon. This modi-

fier is very good for producing very nasal, digi-
tal sounding distortion.,

Because of the way in which they modify a
signal's amplitude, the third row of Modifiers
are useful for obtaining effects reminiscent of
conventional compressor and expander units.
Use the left one for "compressing”, and the
right one for "expanding". After you have
applied either of these to a sound, experiment
further with modifying the Waveshaping func-
tion using the "smoothing” and "randomizing"

| modifiers located in the bottom row of the

palette. Many subtle variations are possible
with them.,
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Stretcher Module

Time Expansion

Resonance Effects

This module is good for creating a number of
different effects, from simply lengthening a

| sound, fo adding pitch to non-pitched
sounds.

| To use the Stretcher to "expand time" in a
pitched sound, the Stretcher's Frequency pa-
rameter must match the fundamental fre-
guency of the sound. Forinstance, if a piano
sample has a fundamental frequency of 440
hz, the Stretcher's Frequency should be set to
440 hz. If you are not sure of a sample's fun-
damental frequency, you can derive it using
the following method: 1) Create a short, one
period loop. 2) Play the loop to make sure
that its pitch matches the overall pitch of the
sample. 3) Get Info on the sample using its
Info box, and note the Loop Frequency. 4)
Set the Stretcher's Frequency to that fre-
guency. Any frequency differences between
the Stretcher and its input will result in ampli-
tude modulation effects, which can obscure
the pitch and character of the input sound by
adding enharmonic tones to it. Of course, this
can sometimes produce redlly intferesting
resuits. As always, experimentation is encour-
aged.

To add pitch content to an non-pitched
sound setf the Amount parameter to a high
level, and experiment with different frequency
seftings. Short percussion sound work well us-
ing this technique. Adding a resonator can
also enhance this technigue.

Extraterrestrial Choir I One particularly interesting use for the

Section 6 - User Tips

Stretcher is as a processor for speech and
vocal samples. This can be good for creating
‘other-worldly" effects.
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This Module functions exactly the opposite of
the Stretcher; it allows pitched sounds to be
shortened without effecting their pitch. If
sound is non-pitched, or if there is a frequency
mismatch, amplitude modulation effects will
occur. The same fechniques used for deriving
the Stretcher's frequency apply to the Time
Compressor.

The Time Compressor is great for processing,
altering, and distorting acoustic sounds, espe-
cially those with rhythmic and pitch content.
You will find that a range of different effects
can be achieved by setting the Amount pa-
rameter to arelatively high level and experi-
menting with different Frequency settings.

Both the Time Compressor and the Stretcher
can be particularly interesting when placed
after a Delay Module with a fairly high Feed-
back and Delay Time settings. Experiment with
mixing a compressed or stretched delay with
the original input signail.
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Tuned Percussion

Subtle Enharmonics
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I The Resonator is another module which can

91

add pitch content to an non-pitched sound,
as well as accentuating a particular fre-
quency in a pitched sound. Resonance is a
fairly versatile effect. Used in small amounts, it
can subtly emphasize certain harmonics in
some sounds. Used in the extreme, it can over-
power a sound's inherent frequency spec-
trum, and impose an entirely different one
over it,

The resonator is very effective on percussion
sounds; it can drastically alter their character,
and dllow them to be tuned to a desired
pitch. Resonance will be most prevalent
when the frequency selected is strong in the
input signal,

In addition to emphasizing the harmonics of a
pitched sound, the resonator can also bring
out enharmonics. Sounds with fast atfacks
(pianos, guitars, etc.) are best suited for this
tfechnique. Set the frequency parameter to a
non-harmonic value and increase the reso-
nance amount until enharmonics are notice-
able during the attack. You should be able
find a resonance level that will give the sound
an interesting attack without making the en-
tire sound dissonant,



odulation Module

Amplitude
Modulation

Frequency
Modulation

Pitch Modulation

ction 6 - User Tips

92

Depending on the way it is used, the Modula-
tor can produce a very wide range of differ-
ent effects:

Try using AM for nasal, quasi-distorted effects.
AM works well for "dirtying-up” just about any-
thing. but really outlandish things are possible
with acoustic instrument samples. Try both
sampled and synthetic modulation sources.

Using FM will generally add high frequency
harmonic content to a sound. This can pro-
duce sounds similar to those produced by FM
synthesizers like the Yamaha DX7™, When
acoustic instrument samples are moduiated
by other sounds, they will change radically. A
sine wave is usually a good candidate for
frequency modulation. This is an area well
worth investfigating.

Most conventional hardware based synthesiz-
ers have dedicated LFOs of some kind. Tur-
bosynth instead offers the basic building block
SO you can build and customize your own
modulator. Use the PM setting, and use an
Oscillator Module as the "Modulator" input;
the oscillator waveform will determine the LFO
waveshape. Set the oscillator's frequency
parameter to a fairly low frequency, usually
less than 10 Hz, and connect the oscillator to
the modulator, Experiment with creating
complex modulations by using multiple wave-
forms in the modulating oscillator.
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Spectral Inverter |
Module

The Clink

With Delay

Switch Methods

Section 6 - User Tips

In addition to Turbosynth's original Spectral
Inversion method (type A), version 2.0 also
offers Type B, a new variety of Spectral Inver-
sion. Type B tends to produce more upper
mid range frequencies than Type A. The best
candidates for either type of spectral inversion
have a broad range of frequencies (e.g. per-
cussion, pianos, etc).

The Spectral Inverter can, among other things,
be used to generate a very clean, pointed
metallic "clink” which is very effective when
placed at the front of a sound. Use a very
fast-decaying envelope, starting at the top
edge of the graph, and ending at the bot-
tom.

When working with Delays, try patching the
delayed signal through a Spectral Inverter, for
unusual echo effects.

Try applying Type B Spectral Inversion to
patches that you have developed using the
original method. Since Type B Inversion tends
to sound louder than Type A, you may want to
adjust the wet/dry mix envelope.



itch Shiffer Module

One useful application for the Pitch Shifter is to
correct pitch discrepancies between different
modules in a patch. This problem can be
common when using Samples in conjunction

| with Oscillators.

Chorusing }

Extreme Shifting
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Detuning effects are simple to create with the
Pitch Shifter. Set the Fine control for about +/-
10 cents (higher for more extreme effects),
and use a Mix setting of about 50%. Since the
pitch shifting algorithm also effects the length
of the input, it is best to use negative
detuning. This way sounds that do not decay
to zero will be mixed with a longer version of
itself. Hence, there won't be any glitches at
the end of the mixed sound.

Try using the Pitch Shifter to transpose Samples
out of their normal range. This will often
change their character drastically, and can
render them utterly unidentifiable. For ex-
ample, a guitar sample transposed down two
octaves can become an inferesting, perfectly
usable bass sound; cymbals transposed down
can tum into gongs, bass sounds fransposed
upward can become mutant clavinets, and
SO on.
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Sample Module

Sample Your Synths

Crossfade Looping

Normalize after
Crossfade Looping

Auto Looping

Section 6 - User Tips

If you have a favorite synth whose character

you particularly like, try sampling some of its
‘ best sounds into your sampler and transferring

them to your Mac (or, if you own an AD IN
and Sound Accelerator, sample directly into
Turbosynth). You can then use Turbosynth as a
extension of your synth’s own sound creating
possibilities. The Resonator, Stretcher, Wave-
shaper and Spectral Inverter Modules can be
especially effective for performing radical
alterations on sampled sounds which would
be nearly impossible to accomplish outside of
Turbosynth. When these modules are used
with synthesizer samples the results can be
unusual and interesting.

Before using the Crossfade Looping function,
try to position the sample's loop markers
roughly in an area which will be conducive 1o
a good-sounding loop. Usually, positioning
the loop start and end at zero-crossing points
(the places where the waveform is crossing
the zero line) is a good idea. Also, since
Crossfade Looping uses the sound data on
both sides of each loop marker, be sure to
position the loop markers with ample space
from each other, the sound start, and the
sound end.

Due to the nature of Turbosynth's Crossfade
Looping algorithm, some of a sample's gain
may be lost in the crossfading process. Use
the Normalize option in the Gain Change icon
to boost a crossfaded sample back up 1o ifs
maximum level,

The Auto Loop function is designed to help
find poinfs in a sample which may be good
candidates for a loop. This function has no
aesthefic sense however; only your ears know
the difference between a good loop and a

|
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 IN™ Owners

bad loop. The Auto Loop arrows will give you
loop points with similar amplitude and slope.
It's up o you to select the best of the opftions
provided,

When sampling sounds with slow attacks, it is a
good idea to set the Threshold control to zero
to avoid missing any low-level sound at the

| start of the sample. This forces the sampling

Sample rate
mismatch
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process to start as soon as the Sample icon is
clicked.

The AD IN™ samples at a fixed rate of 44.1
kHz, which is generally regarded as an industry
standard. However, if your sampler is not ca-
pable of a 44.1 kHz sample rate, you will en-
counter transposition problems when you
tfransfer AD IN-derived sounds to it. In this situ-
ation, you have two possible courses of ac-
fion: 1)You can use Turbosynth's ability to per-
form sample rate conversion in order to
match the rate your sampler, which can
sometimes distort a sample, or 2) send the
non-converted sample to your sampler and
simply alter the sample's “root key". "Root key"
is a common term used to describe the key in
your sampler's keyboard setup at which the
sample is played back at its original pitch.
You may have 1o also adjust the sample's fine
tuning to achieve the correct pitch.
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General Suggestions

Perpetual Patching

Sample Components

Hybrid Sounds
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In addition to the "Compact Memory" and
"Release Clipboard" commands, the "Convert
to sample" option in the Edit menu is useful for
conserving and regaining memory, as de-
scribed earlier in this manual. However, it can
also be used as a means of creating ex-
tfremely complex timbres. Although Tur-
bosynth has nearly unlimited patching capa-
bilities, you may find that your Macintosh can
run out of memory before you have run out of
ideaqs. If this occurs, don't panic; simply con-
vert the Iast module in the patch to a sample,
and use it as the starting point for another
patch. This process can be repeated until you
are satisfied with the results.

The "Save output as soundfile" command can
| be atimesaver, particularly if you often use a
certain combination of modules to create a
component of a sound. For example, if you
create a sound resembling the "tine" of an
electric piano, you may later want to use that
sound in another patch. Saving the sound's
output as a soundfile will allow you to quickly
recall the "tine" without having fo recreate it
from scratch. Also, it is generally good prac-
tice to save a Parameter document for any
Turbosynth sound you have created which
you like. This ensures that you can go back
and examine or alter it at a later date, so
make sure to do this before erasing any mod-
‘ ules.
Attention, fans of the Roland D-50™ , Korg
M1™, Kawai K-1™-and similar synthesizers! |If
you like the sound of sampled attacks on syn-
thesized sounds, Turbosynth can open up
many new possibilities for you. Spend some
time creating a few different oscillators. When
you're happy with the results, browse through
your sample library and select a few sampled
| sounds with interesting attacks. Open the
97



The Completion
Backwards Principle |
| wards principle. Rather than starting from

ction 6 - User Tips

Systems

| samples into Turbosynth Sample Modules. Use

98

the Clear command to remove any un-
wanted sound data occurring after the at-
tack portion of each sample (you can audi-
tion a particular region of a sample by select-
ing it with the mouse and clicking on the
Speaker icon). If necessary, route the trun-
cated sample into an Amplitude Envelope
module to fade out the abrupt cutoff at the
end of the sound. You can now experiment
with grafting the sampled attacks on to your
new oscillators, by patching both into a Mixer
and adjusting their relative levels. Any pitch
discrepancies between the samples and your
oscillators can be easily corrected by either
adjusting the frequency parameter of the
oscillator or by patching the sampled sound
through a Pitch-Shiffer and matching up the
respective pitches,

Turbosynth's flexibility and power allow sounds
to be designed using the Completion Back-

scratch and tweaking, try to conceptualize all
of the various characteristics of a sound and
then try readlize them. Start by envisioning the
final sound, then work backwards to define
the sound's components. You can construct
its various elements separately, and combine
them in endless ways.  Since you're not lim-
ited to fixed number of oscillators, filters etc.
you are more free to divide a sound down
into small components.

The old adage "the whole is greater than the
sum of its parts” should be kept in mind while
using Turbosynth, Although interesting sounds
can be created using small numbers of mod-
ules, in some cases the most effective ap-
proach is the use of "systems" of modules. A
‘system” consists of a large numbers of proc-
essing modules used in combination to proc-
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Life after Turbosynth
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ess multiple Samples or Oscillators (this is an-
other memory intensive process, so upgrade
that Macintosh now!). For example, a patch
might run a sampled sound through a bank of
resonators, each resonator tuned to a differ-
ent frequency in a harmonic series. If you de-
velop a particularly interesting "system® patch
that processes a Sample or Oscillator, be sure
to try other Samples or Oscillators with that
"system" to see how they will be affected.

Remember that when you use the "Save out-
put as soundfile" command from the File
menu, you are doing two things; you are syn-
thesizing the current patch info a sample, and
creating a Macintosh soundfile document of
that sample in Digidesign's widely-adopted
Sound Designer format. This file type is com-
patible with most commercially available Mac
sample-editing packages, such as Sound De-
signer, Sound Designer Il, and Blank Software's
Alchemy. Once opened into one of these
programs, your Turbosynth sounds can edited
using the tools available in that program,
opening up further possibilities.



mpler Suggestions

Angalog processing

Velocity crossfading

| Creative use of your sampler's own processing

power will allow you to take finished Tur-
bosynth sounds a step further. A few ex-
amples:

' One of the simplest technigues for making a
sample more expressive is 1o use key velocity
to affect the attack time, filter cutoff or enve-

‘ lope amount of the sound.

If your sampler has velocity crossfading or
cross-switching abilities, use them! Create
keyboard "presets” containing several versions
of a sound, set up to be triggered by different
key velocities. For example, add a resonator

' to one of your favorite patches. With your
sampler, use velocity to switch between the
straight sample and the resonated sample.

\ This will allow you to accentuate overtones as

|

you play harder.

Chorusing | Forrich "chorus® effects, stack fwo identical

sounds on top of each other across your
sampler's keyboard, and use LFO modulation
to vary the pitch of one sound. Assign the
modwheel 1o vary the depth of the effect.
This technique has two advantages over using
Turbosynth to create the same effect. First,
chorused sounds are much more difficult to
loop than "dry" sounds. Also, real-fime conirol
over chorusing via the modwheel is more flex-
ible than the fixed chorusing offered by Tur-

[ bosynth. The main drawback of this tech-

Transposition |
Layering

|
10
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nique is that it cuts your sampiler's polyphony
(the number of simultaneous notes) in half,

In addition to slight detuning, extreme
detuning can also be very effective. Using
multiple copies of a sound with different
tfunings, filtering and amplitude envelopes
can yield very good results. For instance. if a
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Section 6 - User Tips

sound lacks a strong atfack, try making a few
copies of the sound in your sampiler, placing
very short amplitude envelopes on them and
transposing them up about two or three oc-
taves. This should add a bright, metallic qual-
ity or prominent "clink" fo the start of the
sound.
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m New: Opens a new Turbosynth document with
%N no modules except the Output Jack. The
number of simultaneously open documents is

New

Dpen... ®0| |

Close sl |- limited by memory.

Sape S| | .

save fs... Open: Opens a previously saved Turbosynth

document. The number of simultaneously

Save a Copy In... <R
open documents is limited by memory.

sape guipul as squnpdille
Sape laap as wrueform

Close: Closes the current Turbosynth docu-
ment. This is equivalent to clicking in the Close

Sapa wavetym \
box in the upper left corner of the document
Get Info %1 | | window.
Mac -> Sampler % | | Save: Saves current document file under ifs
sampler -> Mac %G| | ownname.
Page Setup... Save As: Saves the current document file un-
Print One der a new name.,
Print... ®P
Save a Copy In: Saves a copy of the current
Quit g | | document under a new name without chang-
ing the name of the current document,

Save output as sound file: Saves the sound
| data represented in the Output Jack as a
) Sound Designer sound file.

Save loop as waveform: Saves the sound data
between the extension markers (in the active
Sample module) or the loop markers (in the
Output Jack) as a waveform file.

| Save waveform: Saves the waveform in the
, active Waveform window as a waveform file.

Get Info: Opens the info box of the active win-

) dow. Parameters such as name, sample rate
and length can be edited in the info box.

|
A1
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Mac -> Sampler: Sends the specified sound
file on disk to the sampler selected in the Sam-
pler menu.

| Sampler -> Mac: Requests a sound file from
the selected sampler and saves it on disk.

| Page Setup: Opens dialog box allowing you to
| specify various page orientation options.

! Print One: Prints one copy of the active win-
dow without opening the print dialog box.

| Print: Opens the print dialog box providing
various print options.

Quit: Quits Turbosynth.

| Undo: Undoes the last action.

Undo 2

Cut: Cuts the selected item into the clipboard.
Bt *H As with most Edit menu items, this item can be
Copy %L a module or a selected portion of a sound
Paste wy within the sample module.
Clear %8B
Duplicate %D | | copy: Copies the selected ifem info the clip-
Reverse %R board.
Silence HE

| Paste: Pastes the contents of the clipboard

fonuperl n sampie into the active window.

Eonuetl o paueinpe

Send loop to output Clear: Deletes selected item.

Show Clipboard

Duplicate: Duplicates the selected item in the
program. Since this action does not use the
clipboard, less memory is used than during a
Copy and Paste.

Reverse: Reverses the selected portion of a
sound in a Sample module.

pendix A - Menu Reference
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Sound Driver
Sound Manager
vSound Accelerator

Auto Preview

®T

Parameter Manager...

Y

| Silence: Replaces the selected portion of a

| sound in a Sample module with silence.
Convert to sample: Converts the selected
module into a Sample module, Used to con-
serve memory by converting a module to a
Sample module and erasing the support mod-

| ules.

} Show clipboard: Displays the contents of the
clipboard.

Sound Driver: Is one of three different play-
back options. This is the original Apple sound
playback software. It is currently (as of June,
1989) the best option for Mac Plus and Mac SE
owners,

Sound Manager: Is the Apple sound playback
software devoped for the Mac II. This option
should work with the Mac Plus and Mac SE in
a future release of the Mac system software.
If you get new system software give it atry.

Sound Accelerator: Is a hardware card which
allows real-time computation and 16 bit play-
back. Versions are available for the Mac SE
and the Mac Il

Auto Preview: Causes Turbosynth to automati-
cally compute and play a sound after any
parameter is edited. This option is highly rec-
ommended when using a Sound Accelerator
during oscillator timbre editing.

Parameter Manager...: Allows you to control
the attributes of modules. Attributes include
sample rate, length, and frequency.

Appendix A - Menu Reference



<ai S700/H?000

<ai S900

1sio FZ-1/F2-10M

-mu Emad

-mu Emulator 11

-mu Emulator 111

1sonig Mirage/Multisampler
1soniq EPS

org DSS-1

org DSM-1

nland $S-10/$-220/MKS-100
nland S-50

nland $-550/8-330

IMA (12 bit)

IMA (16 bit)

Setup: Allows you to select the serial port fo
which your MIDI interface is connected and
the clock speed at which it operates.

Keyboard: Displays a musical keyboard on the
screen. Clicking on the keys sends MIDI note
numbers to the MIDI output.

Preview: Allows two fo eight voices of the cur-
rent Turbosynth sound to be played out of the
Sound Accelerator using a MIDI keyboard.
While this feature is not intended to repiace a
dedicated sampler, it is does allow polyphonic
fransposition of sounds using a remote key-
board.

Select the sampler you will be using with Tur-
bosynth from the Sampler menu.

pendix A - Menu Reference
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Appendix B - Shortcuts
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| This Appendix describes some operational

shortcuts that will help you use Turbosynth
more efficiently.

Hitting the space bar is equivalent to clicking
on the speakericon. To stop sound playback
you can either click the mouse or wait until
the sound has finished playing.

To play an individual module from the main
window, hold down the option key and click
on a module icon. Turbosynth will play the
sound at this point in the signal path. If neces-
sary, Turbosynth will pause to recalculate the
sound buffer.

Likewise, to play a waveform from an oscilla-
tor window, hold down the option key and
click on a wavefom icon. Turbosynth will con-
tinuously play the waveform until the mouse
button is released.

To quickly switch between the arrow, patch
connector, and eraser in the main window use
the tab key.

To play a loop from a Sample window, hold
down the command key and click on the
speakericon. Turbosynth will continuously
play the looped selection until the mouse but-
fonis relecsed.

To adjust loop points within a loop window,
click on a point in the left half of the loop win-
dow to specify aloop end point. The point at
which you click will then shift right and be-
come the new loop end. Likewise, if you click
in the right half of the window you can specify
aloop start point. This method is much faster
than using the scroll arrows to move the loop
points large distances. You may still want 1o
use the scroll arrows 1o “fine-tune" the loop.



d Disk Installation ’ Turbosynth's copy protection allows you to

Install Turbosynth
a Hard Disk:

install the program on a hard disk without
requiring you to insert the master disk when
| you start the program.
Never delete the Turbosynth program icon
from a hard disk! You must use the Remove
| function for Turbosynth to be re-installed on a
hard disk.

1) Boot the Macintosh from the hard disk.

2) Insert the original Turbosynth master disk (a

copy won't work). The disk must be unlocked.

Start Turbosynth from this disk by double-click-
( ing on the Turbosynth icon.

3) A hard disk install/remove menu will ap-
‘ pear. Click on the Install button.

4) A dialog box will appear that lists the avail-
able disk volumes and folders that Turbosynth
can be installed on. Use the Disk button to

/ select the hard disk or hard disk volume on
which o install Turbosynth. You cannot move
Turbosynth to a different volume once it has
been installed.

5) Click once on the Install button. After the
installation is complete the hard disk install/
remove menu will appear. Click on the Exe-
cute Installed button to run Turbosynth, or the
Finder button to quit to the Finder.

dendix C - Hard Disk Installation
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To Remove
Turbosynth from a
Hard Disk:

Programmer
General's Warning:

| 1) Boot the Macintosh from the hard disk.

| 2) Insert the original Turbosynth master disk (a
copy won't work). The disk must be unlocked.
Start Turbosynth from this disk by double-click-
ing on the Turbosynth icon.

3) A hard disk install/remove menu will ap-
pear. Click on the Remove button,

4) A dialog box will appear that lists available
disk volumes and folders. Use the Disk button
to select the hard disk or hard disk volume on
which Turbosynth is installed. Locate the Tur-
bosynth file and select it (click on its name).

5) Click once on the Remove button. After
the removal is complete, the hard disk install/
remove menu will appear. Read the dialog
box; it should say that "you have the option to
install 1 copy...". Click on the Finder button to
quit to the Finder.

Before running a backup utility, "virus vaccine'
or hard disk optimizer, you must de-install your
copy of Turbosynth. Disk ufilities can some-
times affect the invisible copy protection file
on your hard disk and destroy the keyless op-
eration of the program.

A7

Appendix C - Hard Disk Installation



NOTE TO FREQUENCY CONVERSION CHART (C4 = MIDDLE C; A4 = 440H7)

>pendix D - Note to Frequency Chart

note frequency (Hz) note | frequency (Hz) note | frequency (Hz)
Co 16.35 Hz c3 130.81 Hz 6 1046.50 Hz
co* 17.32 Hz Cc3* 138.59 Hz ce= 1108.73 Hz
DO 18.35 Hz D3 146.83 Hz D6 117466 Hz
DO= 19.45 Hz D3* 155.56 Hz DE* 124451 Hz
EO 20.60 Hz E3 16481 Hz E6 131851 Hz
FO 2183 Hz F3 17461 Hz F6 1396.91 Hz
FO* 23.12 Hz F3= 185.00 Hz F6= 1474.98 Hz
GO 2450 Hz G3 196.00 Hz G6 1567.98 Hz
GO* 25.96 Hz G3* 207.65 Hz G6* 1661.22 Hz
20 27.50 Hz A3 220.00 Hz 26 1760.00 Hz
AO* 29 14 Hz A3 233.08 Hz AG* 1864.66 Hz
BO 30.87 Hz B3 246.94 Hz B6 1975.53 Hz
el 3270 Hz c4 26163 Hz c7 2093.01 Hz
Ci1* 34.65 Hz c4* 277.18 Hz c7= 2217.46 Hz
Di 36.71 Hz D4 293.67 Hz D7 2349.32 Hz
Bif= 38.91 Hz D4* 31113 Hz D7# 2489.02 Hz
El 4120 Hz E4 329.63 Hz E7 2637.02 Hz
o 43.65 Hz F4 349.23 Hz F7 2793.83 Hz
Fi= 46.25 Hz Fq+ 369.99 Hz F7% 2959.96 Hz
Gl 49.00 Hz G4 392,00 Hz G7 3135.96 Hz
Gl1* 51.91 Hz G4* 41531 Hz G7% 332244 Hz
Al 55.00 Hz A4 440.00 Hz A7 3520.00 Hz
Al 58.27 Hz A4* 466.16 Hz AT 372931 Hz
Bl 61.74Hz B4 493.88 Hz B7 3951.07 Hz
€2 65.41 Hz c5 523.25 Hz C8 4186.01 Hz
C2* 69.30 Hz 5= 554.37 Hz Cg* 443492 Hz
D2 73.42 Hz DS 587.33 Hz D8 4698.64 Hz
D2= 77.78 Hz D5* 622.25 Hz Dg* 4978.03 Hz
E2 82.41 Hz ES 65926 Hz E8 527404 Hz
F2 87.31 Hz F5 698.46 Hz F8 5587.65 Hz
F2= 92.50 Hz F5* 739.99 Hz Fg* 5919.91 Hz
G2 98.00 Hz G5 783.99 Hz G8 6271.93 Hz
G2* 103.83 Hz GS* 830.61 Hz G8* 6644.88 Hz
A2 110.00 Hz £5 880.00 Hz 28 7040.00 Hz
A2# 11654 Hz AS*# 93233 Hz AB* 745862 Hz
B2 123.47 Hz BS 987.77 Hz B8 7902.13 Hz
A8
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Appendix E - Credits

Turbosynth Concept/Functional Design:
Mark Jeffery, Peter Gotcher, Evan Brooks

Software:
Mark Jeffery, Evan Brooks, Andy Hong

Manual:
Scoft Wilkinson, Peter Freeman, Peter Gotcher,
Mark Jeffery, Caitlin Johnson

Special thanks to:
Peter Freeman, Dennis Camberry, Rob Cam-
panella, Bill Koepnick, Chris Now, Jeff Cohen

Turbosynth was developed using Apple Com-
puter Inc.'s MacApp™ source code library.
MacApp is ©1985,1986,1987, 1988, 1989 Apple
Computer Inc. Apple Computer Inc. makes
no warranties whatsoever, either express or im-
plied, regarding this product, including war-
ranties with respect 1o its merchantability or its
fitness for any parficular purpose.

| The MacApp software is proprietary to Apple
Computer Inc., and is licensed to Digidesign
Inc. for distribution only for use in combination
with the Turbosynth program.
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Turbosynth SC Project Team:

Tina Chavez, Robert Currie, Midori Duarte, Mike Freitas, Bobb Haskitt, David Hipshman, Roger Keller, Charles Maynes,
Tom McTavish, Ed Rios, Karen Robb

Turbosynth SC Software:

Mark Jeffery, Evan Brooks, Andy Hong, David Hipshman, Robert Currie
Turbosynth SC 2.2 Manual Addendum:

Mike Freitas

Package and Turbesynth Graphic Design:

Kristine Ekstrand

Product Management:
Bobb Haskitt

Special Thanks to:
Charles Maynes, Peter Freeman, Tom McTavish, Kim Haskitt and the rest of the ever growing Digi gang.

Copyright

This manual is copyrighted ©1993 by Digidesign, Inc. with all rights reserved. Under copyright laws, this manual may not be duplicated
in whole or in part without the written consent of Digidesign.

All trademarks are property of their respective holders.

All features and specifications subject to change without notice.

©1993 Digidesign Inc.
All rights reserved
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DIGIDESIGN END USER LICENSE AGREEMENT

NOTICE TO END USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT PRIOR TO USING THE SOFTWARE PROVIDED WITH THE
AGREEMENT (Turbosynth SC™). USE OF THE SOFTWARE CONSTITUTES YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO
THE TERMS OF THE AGREEMENT, PROMPTLY RETURN THE SOFTWARE AND THE ACCOMPANYING ITEMS (INCLUDING WRITTEN
MATERIALS AND CONTAINERS) TO THE LOCATION WHERE YOU OBTAINED THEM FOR A FULL REFUND.

1. License Grant. Digidesign grants to you (either as an individual or entity) a personal, non-transferable, and non-exclusive right to use the
copy of the object code version of the SOFTWARE provided with this license. You agree you will not copy the materials accompanying the
SOFTWARE.

2. Copyright. You acknowledge that no title to the intellectual property in the SOFTWARE is transferred to you. You further acknowledge that
title and full ownership rights to the SOFTWARE will remain the exclusive property of Digidesign or its suppliers, and you will not acquire any
rights to the SOFTWARE except as expressly set forth above. You agree that any copies of the SOFTWARE will contain the same proprietary
notices which appear on and in the SOFTWARE.

3. Reverse Engineerlng. You agree that you will not attempt, and if you are a corporation, you will use your best efforts to prevent your
employees and contractors from attempting to reverse compile, modify, translate, or disassemble the SOFTWARE in whole or in part.

4. Limited Warranty. Digidesign warrants that the SOFTWARE will perform substantially in accordance with the accompanying
documentatlon and that the documentation and diskettes are free from any physical defects for a period of ninety (90) days from the date of
purchase (“Limited Warranty”).

5. Customer Remedles. Digidesign’s entire liability and your sole and exclusive remedy shall be, at Digidesign’s option, either to (a) correct
the error, (b) help you work around or avoid the error or (¢} authorize a refund, so long as the SOFTWARE, documentation and diskettes are
returned to Digidesign with a copy of your receipts. This Limited Warranty is void if failure of the SOFTWARE has resulted from accident,
abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder of the original warranty period.

6. No Other Warranties. DIGIDESIGN DOES NOT WARRANT THAT THE DIGIDESIGN SOFTWARE IS ERROR FREE. DIGIDESIGN DISCLAIMS
ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABIL-
ITY, FITNESS FOR A PARTICULAR PURPOSE AND NON INFRINGEMENT OF THIRD PARTY RIGHTS WITH RESPECT TO THE SOFTWARE, THE
ACCOMPANYING DOCUMENTATION OR DISKETTES. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSIONS MAY NOT APPLY TO YOU. THIS WARRANTY
GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO JURISDICTION.

7. Term, This Agreement is effective until terminated. You may terminate this Agreement at any time by destroying the SOFTWARE together
with any copies in any form. Digidesign may terminate this Agreement if you fail to comply with any term or condition herein.

8. Severabllity: In the event of invalidity of any provision of this Agreement, the parties agree that such invalidity shall not affect the validity
of the remaining portions of this Agreement.

9. No Liability for C q ial D ges. IN NO EVENT SHALL DIGIDESIGN BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, SPECIAL,
INCIDENTAL OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE USE OF THE DIGIDESIGN SOFTWARE, EVEN IF DIGIDESIGN
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL DIGIDESIGN’S LIABILITY FOR ANY CLAIM, WHETHER
IN CONTRACT, TORT OR ANY OTHER THEORY OF LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU.

10, Export. You agree that you will not export or re-export the SOFTWARE without the appropriate United States or foreign government
licenses.

11. Governing Law. This Agreement will be governed by the laws of the State of California as they are applied to agreements between
California residents entered in o and to be performed entirely within California. The United Nations Convention on Contracts for the
international Sale of Goods is specifically disclalmed.

12. Entire Agreement. This is the entire agreement between you and Digidesign which supersedes any prior agreement, whether written or
oral, relating to the subject matter of this Agreement.

U.S. GOVERNMENT RESTRICTED RIGHTS
If this product Is acquired under the terms of a: DOD contract : Use, duplication or disclosure by the Government is subject to restrictions as set
forth in subparagraph (c) (1) (li) of 252.227-19(a) through (d) and restrictions set forth in the accompanying end user agreement. Unpublished-
rights reserved under the copyright laws of the United States.

Should you have any questions concerning this Agreement, or if you desire to contact Digidesign for any reason, please write:
Digidesign, Inc., 1360 Willow Road, Suite 101, Menlo Park, CA 94025.



Digidesign’s Update and Support Policy

Digidesign will provide telephone support to registered users for a period of one year from
the date of original purchase. As a new Turbosynth SC owner, the first action you should
take is to send in your registration card. You must be a registered owner if you want to
receive telephone support, program updates, or new product information. Once you are a
registered owner, program updates will be made available to you for a minimal charge.

Digidesign is serious about customer support, and is strongly committed to a continuing
relationship with you after your purchase. As a registered Turbosynth SC owner, you can
contact Digidesign directly with any questions or problems. A Turbosynth SC Technical
Support person will be standing by to help you during business hours (Monday to Friday,
9:30 to 5:30 PST). For customer service, call (415) 688-0744.

Digidesign is made up of people who are very interested in audio and the recording process
as a whole. Become one of our registered owners and participate in the creative process.

Digidesign



Turbosynth SC 2.2 Manual Addendum

Welcome to Turbosynth SC! This upgrade offers several new features and many enhance-
ments to existing ones including integrated SampleCell II support, more playback options,
new modules, stereo capabilities, and more. Please take the time to read this Addendum to
become familiar with all these additions. Here’s what you'll find in the Turbosynth SC 2.2
Manual Addendum:

e Section 1: Getting Started gives you an introduction to Turbosynth SC, and tells you
what you'll need to use Turbosynth SC, how to install it, and how to configure it
on your Macintosh.

e Section 2: What's New lists the features that have been added since version 2.0.
* Section 3: What has Changed lists all other changes to Turbosynth SC since version 2.0.

o Section 4: Using SampleCell II with Turbosynth SC explains Turbo’s SampleCell 11
support and shows what a potent combination these two applications can be.

Section 1: Getting Started

What is Turbosynth SC? Turbosynth SC is software that allows you to create and manipu-
late sounds for Digidesign’s SampleCell™, Pro Tools™, Sound Tools™ and Audiomedia™
digital recording and editing systems. Turbosynth SC uses a “modular” approach to synthe-
sis, by providing a variety of modules such as oscillators, filters, and waveshapers to create
and modify sounds. This approach to synthesis has been used since the earliest days of
electronic music, when analog synthesizers were programmed using patch cords. While this
type of modular synthesis provided complete flexibility — modules could be patched in any
configuration, allowing the user to literally “design” any imaginable synthesizer architecture
— patch cords were clumsy to use and patches couldn’t be stored in computer memory.

Turbosynth SC combines the flexibility of modular synthesis with the power and conve-
nience of modern digital synthesis, sampling, sound processing and hard disk storage
technology. This combination allows you to draw on the strengths of each sound producing
method to produce the widest possible range of sounds. Once created, these sounds can be

opened in SampleCell or one of Digidesign’s digital recording systems and played back via
MIDI or from a “playlist.”
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What You’'ll Need

In order to use Turbosynth SC, the following is required:

e System 7.0 or later, in 32-bit mode, with a minimum of 5 Megabytes of RAM.
While Turbosynth SC will operate with as little as 2 Megabytes of available RAM,
we strongly recommend 8 Megabytes to take full advantage of Turbosynth SC, as
well as to be able to use some of the larger Example files.

Optional (but highly recommended) equipment Includes:

¢ A SampleCell playback card, or any Digidesign DSP card (AudioMedia 1I,
AudioMedia LC, Pro Tools, Sound Tools, etc.). A SampleCell card will provide 16-
bit playback fidelity, and a DSP card will provide high-fidelity output and direct
sampling input.

NOTE: Without a SampleCell or DSP card you will not be able to use Turbosynth SC’s
Diffuser module. If you open Turbosynth documents which already contain a Diffuser,
the signal will automatically pass through the module (as if it was in a “bypass” mode).

Installing the Turbosynth SC Software

This section shows you how to install Turbosynth SC on your hard disk. We strongly
recommend you carefully follow the steps outlined below. In other words, this is not the
time to exercise your creativity — you’ll have plenty of time for that later, after you've
correctly installed and authorized your copy of Turbosynth SC. Turbosynth SC allows you
to authorize up to three hard disks for Turbo-use.

Important

We know, copy protection can be an inconvenience. However, the installation procedure
you'll follow with Turbosynth SC is fast, flexible and does not require a serial number. As
long as you hold onto your master disk and follow the instructions in this section you
should be able to use Turbosynth SC without a hitch.

6 Digidesign



Please, do NOT run Turbosynth SC directly from the floppy disk. (Floppy drives are too slow
for Turbosynth SC.)

To install Turbosynth SC on your hard disk:
e Insert the Turbosynth SC Master Disk into any floppy drive.

® Double-click the Turbosynth SC icon. The following dialog box appears:

You are running Turbosynth SC™ from the master
& diskette. Ruthorized copies can run on your hard

disk without requiring this master diskette.

select Setup to Install or remove authorization for

any avatllable hard disk. Select Continue to run thls

master copy or Quit lo quit this applicetion.

(_auit__) (continue |

e Click Setup. If you click Continue, you will still be able to install Turbosynth SC, but
you will not have authorized your hard disk. If you install Turbosynth SC without
authorizing your hard disk you will be required to insert the master disk each time
you start up the program. Therefore, don't click Continue unless you need to
somehow limit access to your installed copy of Turbosynth SC.

After you click Setup, the following dialog box appears:

O—m Turbosynth SC™ will run on any authorized hard disk
=95 without requiring the master diskette. You have a
remaining authorization count of 3.

Select Authorize to install authorization to a hard disk or
Deauthorize to remove authorization. Select Quit to quit.

(Ruthorize | [peeuthorize)

e Click Authorize. The next dialog that appears lets you do two things: specify which
hard drive will be authorized for Turbosynth SC, and copy the application to the
authorized drive.
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O—m Hu\nnrize:
o

Click 0K to authorize Turbosynth SC™ to run on the
selected hard disk. {f successful, your suthorization
count will be decremented.

[1Mmaxke a copy of the application on the hard disk.

» Select the hard disk on which you want to install Turbosynth SC using the pop-up
list (in the example above, “Mac HD" is selected).

» Check Make a copy of the application on the hard disk... If you do not check this
checkbox, the selected hard disk will still be authorized, but you'll have to manu-
ally drag-copy the application from the floppy disk later.

* Click OK.

A standard Macintosh file dialog box appears asking you to indicate where on the
selected and authorized hard disk you want Turbosynth SC to be installed. (We
suggest you create a new “Turbo” folder (by clicking the New Folder button) before
installing the application). Do NOT rename the application.

* Choose the location for Turbosynth SC and click Save.
You'll now see a couple of dialogs go by as the installer first authorizes your hard

disk, then copies the application from the floppy. When these two processes finish,
this dialog appears:

Turbosymh'sc'" s now authorized to run on “Mac
HD". You have a remaining authorization count of 2.

[ x )

This dialog box confirms that your hard disk is now authorized to run Turbosynth
SC, and tells you how many more authorizations your disk has left (in the example
above, the disk has a remaining authorization count of 2).

¢ Click OK. The following dialog appears again:

Digidesign



O—m Turbosynth $SC™ will run on any authorized hard disk
£33 without requiring the master diskette. You have @
remalning authorization count of 2.

Select Authorize to install authorization to a hard disk or
Deauthorize to remove authorization. Select Quit to qult.

(Autnorize | (Deauthorize|

e Click Quit and, when you return to the Finder, eject the Turbosynth SC Master disk.

To learn how to “Deauthorize” your hard disk, see the following section
“Deauthorizing your hard disk.”

This completes the installation and authorization of Turbosynth SC. You can now complete

the procedure by installing the supporting files from the Turbosynth SC Miscellaneous Files
floppy disk.

You are now ready to start using Turbosynth SC! One more thing though, before you get
engrossed in Waveshaping, Spectral Inverting and Diffusing — send in your Registration
card! This will guarantee that you're kept up-to-date with news from us about upgrades to
Turbosynth SC and other Digidesign audio production tools.

About Deauthorizing Your Hard Disk

On an Authorized hard disk, you can start up, use, and even move Turbosynth SC around
without ever being prompted for your master disk. If you use up your three authorizations
(reinstalling Turbosynth SC after a hard disk crash, etc.), no additional authorizations can
occur until you “reclaim” an authorization by using the Deauthorization feature of the
Turbosynth SC installer.

To Deauthorize your hard disk:

e Insert the Turbosynth SC Master disk into any floppy drive connected to the hard
disk that you want to deauthorize.

* Double-click on the floppy disk icon to open it.

¢ Double-click on the Turbosynth SC on the master disk to launch the installer.
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* At the first dialog box, click Setup. The following dialog appears:

o Turbosynth SC™ will ryn on any suthorized hard disk
% without requiring the master diskette. You have 8
remaining suthorization count of 2,

Select Authorize to instell authorization to a hard disk or
Deauthorize to remove authorization. Select Quit to quit.

Authorize Deauthorize

=)
l%
-,

* Click Deauthorize. Next, this dialog box appears:

Oozm ueaumurize:

25 phick BK 10 deauthorize the selected hard disk. If
successiul, your sulhorizotion count will be
incremented and your master disketie will be
required to run Turbosynth SC™.

* Make sure the appropriate hard disk is selected (use the pop-up menu to select a
different disk, if necessary) and click OK.

A message box will appear briefly while deauthorization takes place, after which a
dialog appears confirming that you have reclaimed one authorization.

flutharization to run Turbosynth SC™ hes been
removed from “Mac HO®. You have a remaining

authorization count of 3,

¢ Click OK. When the next dialog box appears (the “Authorize/Deauthorize” dialog),
click Quit to return to the Finder.

Deauthorization is now complete. If you now launch Turbosynth SC (assuming you left a copy
on your hard disk) you will see the following dialog box every time you start the application:

3 Plesse insert the original Turbosynth SC™ master
disk Inlp nny syoilahle drive.

Simply insert the master disk and Turbosynth SC will launch.

10
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If you have not already done so, be sure to open and read the Read Me! file on your Misc
Files disk. The Misc Files disk contains a few system utilities which your computer might
need — the Read Me! will tell you whether or not you need any of these files. If you have
any problems or questions about installing, authorizing or deauthorizing Turbosynth SC,
try repeating the steps listed above. If you have tried and still have problems, call Digidesign
Technical Support at (415) 688-0744

Audio Connections

The ideal audio configuration for Turbosynth SC is to use Digidesign’s 32-voice, 32 Mega-
byte SampleCell II sample playback system for audio playback. Turbosynth SC can also play
audio through any Digidesign DSP card (Pro Tools, Sound Tools, Audiomedia, etc.). If you
do not have either of these, you can use the Macintosh internal speaker to hear your
sounds.

If you plan to use SampleCell or another Digidesign DSP card, connect your card’s audio
outputs to your mixer and/or other audio gear. Turbosynth SC files can be either mono or

stereo, so be sure you use two outputs of your audio card for true stereo playback.

This completes the basic installation process. You are now ready to start using Turbosynth SC.

Section 2: What's New

This section tells you what new features you will find in Turbosynth SC. Features added
since version 2.0 are included for those of you who have not upgraded to version 2.1.

Copy Protection

This one should be obvious if you just completed the installation instructions. You must
have a Turbosynth Master disk to start-up Turbosynth SC. The installation instructions
contain everything you’ll need to know about Turbosynth SC 2.2’s copy protection.
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Playback Options

Turbosynth SC is compatible with all of Digidesign’s DSP cards (Pro Tools, Sound Tools I,

Audiomedia II). There are two new Options menu commands, Playback Options and Hard-
. ware Setup, which you use to configure playback for Turbosynth SC. Playback Options lets
| you choose one of three possible playback configurations — a Digidesign DSP card,

SampleCell, or Sound Manager.

[

|

|

|

! Playback Dptions:

@ Digidesign OSP Card
O SampleCefl™

) Seund Manager

i)

L The Playback Options dialog
In the Playback Options dialog:

I * Choose Digidesign DSP Card if you have a Pro Tools, Sound Tools Il or Audiomedia
H II card. Next, open the Hardware Setup dialog and configure the settings appropri-

[ i ately (i.e., make sure the proper card and slot are selected, and that the digital/

Il analog input is set to the desired status).

Hardware Setup
- Track

— Select Card Type:

&

O fudipmedis psp| Slot 13 (DSP 1)
@® Pro Tools Rudiocard | | pleys o
O MegieTime and ®

— Cards To Use:

ol Cord 1: Peripheral:
L sample Rate:
| synt Mode:
i Digital Format:
Ch 1,2 lnput:

Recalibrate Inputs

|
|
| l[ Q Sound Hoealeraio
!
|
(

Hit The Hardware Setup dialog
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Stereo Documents and Stereo Sampling
Turbosynth SC reads and writes Sound Designer II and AIFF files in mono or stereo.

A stereo sample module is represented by two modules representing each channel. Both
modules are linked together so that any changes or edits in one module affect both mod-
ules. When selecting one of these modules the other is also selected. You can unlink them
using the Convert Stereo Sample to Dual Mono command in the Edit menu.

e

A Stereo Sample

If the document is stereo there will be two output jacks. The two output modules will share
the same loop markers, unless there is no sound data in one of the outputs. Because each
output’s sound buffer length can be different, a loop is constrained by the shorter of the two
lengths. Also, reducing the length of one output’s sound buffer may cause a deletion of loop
markers for both outputs if the marker is beyond the new length of the sound buffer. Unlike
the stereo sample modules, crossfade looping is done explicitly for each output module.

A Stereo Output Module

In the Options menu you will find the Stereo Preferences command. This command opens
the Creating Stereo dialog box, which lets you set various preferences for creating, saving and
playing stereo files in Turbosynth SC:
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4 Open A New Document As R:
E (O Meno document.

@® Stereo document.
Opening A Stereo Soundfile:

(@® Dpen both channels.

(O Open specified channel.

CREATING STERED

Direct Sampling:
O Mono
@® Stereo
Empty Sample Module:
@® Mono
QO Stereo

SAVING OA PLAYING R STEREOQ SDUNDFILE
Stereo To Mono:
@ Scale.
O Don't scale.

Maliching Channel Lengths:

; @ Pad shorter length channel.

(O Truncate longer length channel.
Sample Rate:

@ Use highest.
Q Use lowest.

Cancel

(O Use left channel's.
{ Use right channel's.

Stereo Preferences “Creating Stereo” dialog

- Open A New Document As A. Sets the default for new documents to be Mono or
Stereo. When set to Mono Document, all new Turbosynth documents will have a
mono output jack. When Stereo Document is selected, all new Turbosynth docu-
ments will have a stereo output jack.

- Open a Stereo Sound file. With Open both channels checked, Turbosynth will auto-
matically load both channels of a stereo sound file. With Open specified channel
checked, Turbosynth will ask you to specify which channel (right or left) to load.

- Direct Sampling. Sets the default for mono or stereo direct sampling.

- Empty Sample Module. Sets the default type (stereo or mono) for new Sample
modules.

- Matching Channel Length. Sets how you want channels of differing length
“matched” in stereo files, by lengthening the shorter of the two (Pad shorter length
channel) or shortening the longer of the two (Truncate longer length channel).

Digidesign



- Stereo to Mono. Sets the default for whether or not Turbosynth scales a soundfile
when saving a Stereo output as a mono file, or when playing back through Sound
Manager.

- Sample Rate. Let’s you set how Turbosynth resolves sample rate differences between
the two output channels. Choices include Use highest, Use lowest, Use left channel’s
and Use right channel’s.

Memory Indicator

The main window’s info icon (in the tool palette) is now used as a memory indicator. It fills
with black from the bottom up as memory is used. In extremely low memory situations, the
word Lo! will appear at the top of the icon. When this occurs, try the following two things:
open the Info Box and click the Compact Memory and/or Release Clipboard button, or
increase Turbosynth SC’s Finder memory allocation.

Diffuser Module

The Diffuser accepts one input and provides the abiiity to “smear” a signal over time. The
Diffuser can be thought of as a fundamental building block of reverb.

Important

The Diffuser module performs extremely complex math-intensive operations. For this
reason, you must have a Digidesign card such as a Pro Tools, Sound Tools, Audiomedia or
SampleCell card installed in your Macintosh in order to use this module. If there is no such
card physically installed in your CPU, the Diffuser icon will be disabled.
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Diffuse-1

= o
n g Coarse: Fine: Amount ;

22.0ms

The Diffuser
The Coarse and Fine sliders control the amount of diffusion, or “smearing.” The Amount

slider controls the relative level of diffused signal to dry signal. 0% results in no audible
effect, 100% results in full effect.

Convert to Oscillator

In addition to the Convert to Waveform command, Turbosynth SC offers a unique capability
to convert an entire sample into an oscillator.

To convert a sample into an oscillator:
e Select the sample module in the work area of the Main Window.
* Choose Convert to oscillator from the Edit menu.

The following dialog box appears:

This will convert the currently selected
sample module into an oscillator. It
might take a while. No can “Undo".

Extract a waveform every ms
Fundamental frequency: 220.000 | Hertz

[JTrack frequency changes

Cancel

Convert to oscillator dialog box
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“Extract a waveform every” will tell Turbosynth SC how many waveforms you want
the sample broken into. The higher the number you enter here, the more closely
the resulting oscillator will resemble the original sample. The lower the number
you enter, the less recognizable the result. Experiment with different extraction
values to find what works best for you.

The Fundamental Frequency is the fundamental pitch the oscillator will sound.
Change this value to change the pitch of the sound before it is converted to an
oscillator.

Track frequency changes lets Turbosynth SC create multiple waveforms with differ-
ing fundamental frequencies when converting complex samples into oscillators.
Leave this option off to get an oscillator that doesn’t deviate from its fundamental
frequency.

e Set the parameters in the dialog box as appropriate and click OK.

This operation can take a few moments. When conversion is finished, your screen will
return to the Main Window, and the module which you just converted will appear as a
waveform icon.

Windows menu

A Windows menu has been added. This menu lists all currently open Turbosynth SC
document and/or module windows. Choosing an item from the Windows menu makes that
window the “topmost” (i.e., active) window. '

Monitor Loop at Output

Located in the Parameter Manager dialog box (accessed via the Options menu), the checkbox
Monitor Loop at Output provides some flexibility for listening to looped Turbo sounds. When
checked, you can use the normal play functions (space bar, clicking the speaker) from the
main window and hear the loop (if you have set loop start and stop points). If unchecked,
you will only be able to hear the loop from within the Loop Window.
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Section 3: What has Changed?

The following are some of the more significant changes that have been made to Turbosynth
SC since version 2.0. Consult the Turbosynth SC 2.2 Read Me! document for any additional
changes.

® Mac- Sampler, Sampler- Mac commands are no longer supported.

* The Tab key of your computer keyboard toggles between the Arrow, Patch Cord
and Eraser tools.

¢ The File menu command Save Output as soundfile has been replaced by the two
commands Save Output, and Save Output As. These two commands function
similarly to the familiar Save and Save As commands of many Macintosh applica-
tions, and have specific uses when using Turbosynth SC with SampleCell II. Refer
to Section 4 for more information.

o Select All now works in the Oscillator window (to select all waveforms) and in the
Sample Module (to select the entire sample) as well as in the main window.
Previously, Select All only worked to select all modules placed in the work area.

Section 4: Using SampleCell Il with Turbosynth SC

Introduction

If you already use SampleCell, chances are good that at some point you have used Sound
Designer II SC™ to modify a sample you're using in a SampleCell Instrument. If you are
new to SampleCell, or have never used Sound Designer II SC in this fashion, suffice it to say
that switching between these two applications is so easy it makes Sound Designer II SC and
SampleCell work almost as if they were two windows of a single application.

18
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In a somewhat similar fashion, Turbosynth SC can be used as a sound editing extension of
SampleCell. The way it works is like this: come up with a sound in Turbosynth SC, turn on
Auto Update SampleCell, and then save your Turbosynth SC sound as an Output file.
SampleCell will automatically create a new Multi-Sample Instrument and load the sound in
the output file into it. If your Turbosynth SC sound is a stereo sound, SampleCell will create
a Stereo Multi-Sample Instrument, automatically!

If you want to continue creating new Instruments, simply Save Output As (to save a different
version of the Turbosynth SC sound). SampleCell will load each output file as a new
Instrument.

Once an Output file is in an Instrument it can be modified in Turbosynth SC, and automati-
cally updated in SampleCell II, by doing a Save Output. This updates the saved-to-disk
Output file, and SampleCell then updates itself with this new version of the file.

For multi-sampling, the process is slightly different due to the fact that the goal is to create
Multi-Sample Instruments rather than single-sample instruments. Refer to the section Working
with Multi-Sample Instruments later in this appendix for more information.

Before you begin

® Make sure your SampleCell card(s) are installed correctly and operating properly.

» This section assumes you have a working knowledge of SampleCell, and are
familiar with SampleCell Instruments, Banks, Keygroups, Velocity Zones, etc. If you
are not familiar with these terms, you might end up a bit confused by this section.
You must understand the basic operation of SampleCell before proceeding.

You're ready to start hearing what you can do using the combination of Turbosynth SC and
SampleCell!
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Getting Started

Setting up the link between Turbosynth SC and SampleCell is easy. Here’'s how to get the
pair working together quickly:

To setup Turbosynth SC and SampleCell links:

* Open Turbosynth SC and open a sound or create a sound from scratch. This will be
the first sound of your SampleCell Instrument.

¢ Once you’ve got your sound, choose Auto Update SampleCell from the Options
menu. This “turns on” the link between the two applications.

* Choose Save Output from the File menu of Turbosynth SC. A Macintosh save file
dialog appears. Name the output file, select a destination folder and indicate the
desired file format (Sound Designer II, Sound Designer, or AIFF).

When the output file is saved, SampleCell automatically loads it into a new multi-
sample instrument (SampleCell will automatically launch, if it is not aiready
running.) If you want, switch to SampleCell and adjust instrument parameters, or
remain in Turbosynth to further edit the sound:

To edit the sound In Turbosynth SC after It Is In SampleCell:
¢ Modify the sound.

¢ Choose Save Qutput from the File menu. Just like the familiar Save command found
in word-processors, this command updates the earlier output file with the modifi-
cations you have just made. At this point, Auto Update SampleCell tells SampleCell
to load this newest version of the sound, replacing the original but retaining its
keygroup, velocity zone, or other SampleCell parameters. Remember, if you do Save
Output As, SampleCell will create a whole new single-sample instrument with the
new output file instead of updating the existing one.
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Working with Multi-Sample Instruments

You can take advantage of Auto Update SampleCell with multi-sample instruments as well.
Here’s how you should go about creating, and then working with, an instrument contain-
ing multiple Turbosynth SC sounds:

To use muitiple Turbosynth SC sounds In one multi-sample instrument:
¢ In Turbosynth SC, turn OFF Auto Update SampleCell.

¢ Open your first sound and modify it, if necessary. (Be sure to play the sound so
that the signal is present at the Output module.)

® Choose Save Output from the File menu. Name the output file and indicate a
location for it.

¢ Continue in this manner, opening other sounds or modifying your first sound, and
use the Save Output As command to save each variation until you have enough raw
sounds to use in SampleCell (how many is “enough” is completely up to you).

¢ Next, launch SampleCell and create a new, Multi-Sample Instrument. (When
you're ready to be a power user, turn Auto Update SampleCell back on before
saving your last output file. As described earlier, this will launch SampleCell, create
a multi-sample instrument, and load this output file automatically. You would
then move to SampleCell and continue as described below.)

¢ Open the Sample Map window for your new Instrument and click the New Keygroup
button. SampleCell’s Select a file to open dialog appears.

¢ Locate and load the output file(s) you just created in Turbosynth SC as your first
keygroup, then continue adding new keygroups or velocity zones as described in
your SampleCell User’s Guide. Adjust the keygroup and velocity zone boundaries as
you normally would, and, if you like, audition them with your MIDI controller.

You should now have the basic elements of your Instrument in place. It is likely, however,
that you will want to edit your sounds further after hearing them in your instrument. Here’s
how you can take advantage of Auto Update SampleCell for this:
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To edit multi-sample instruments:
o First, save the Instrument (and the Bank), but do not close or quit SampleCell.

* With SampleCell still running, and with your new Instrument still loaded, switch
back to Turbosynth SC.

¢ In Turbosynth SC, choose Auto Update SampleCell from the Options menu.

* Open and modify the sounds as needed, and save the new versions using the Save
Output command. As described earlier, SampleCell will automatically update itself
with these new versions of your sounds.

That covers the basics of using Turbosynth SC with SampleCell. There are, however, several
Preference settings within SampleCell which can speed up a few of the above tasks. These
options include:

® Make One Instrument when multiple sound files are dragged onto the editor. As a
shortcut to launch SampleCell Il you can drag and drop individual or multiple
sound files onto the SampleCell Editor application. When a single sound file is
dropped on the Editor, SampleCell will automatically create a single-sample
instrument with that sound as it launches (no need to click Load, then locate and
open the individual sample). When you drop multiple sound files (perhaps a folder
of 5 or 6 Turbosynth Output files) SampleCell will create that number of single-
sample instruments, unless this Preference is On. When On, SampleCell will load
all the dragged-and-dropped sound files into a single, multi-sample instrument
automatically.

® Default new single sample instruments to Key Track OFF. This Preference tells
SampleCell to keep Key Track Off for all new single-sample instruments. Having
key track off is often desirable for sound effects or other instances where pitch is
irrelevant. Generally, if you have a sound in Turbosynth SC that you want to hear
transposed across the entire keyboard, you would probably not want to have this
Preference On.
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® Automatically remap Instruments in a bank after adding an instrument. This command
spreads all existing instruments in the current bank over a 5§ octave range (i.e. sets
hi/lo MIDI notes), and sets the first samples base note to the center of the range.
For example, if you have S instruments open, the leftmost instrument will be
mapped from CO to B2 with its root note set to F#2. Moving to the right, the next
instrument will be mapped from C3 to B3 with a root note of F#3, and so on.

By configuring these Preferences to match your work habits, your Turbosynth SC/
SampleCell system can be optimized for maximum efficiency.

Don'’t forget, if you have a Digidesign DSP card (Pro Tools, Sound Tools or AudioMedia) and
the requisite audio interface, you can direct-sample into Turbosynth’s Sample module as a
way to collect raw samples for your system.
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